
PX5S-E-2A

E

USER’S GUIDE (Tutorial)

PX-5S

● Before using this Digital Piano for the first time, be 
sure to read the separate USER’S GUIDE (Basics) 
to familiarize yourself with basic operations.
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• This manual uses the numbers and names below to refer to buttons and controllers.

1 BENDER wheel

2 MODULATION wheel

3 K1 through K4 knobs

4 S1 slider

5 S2 slider

6 S3 slider

7 S4 slider

8 S5 slider

9 S6 slider

bkP (POWER) button

bl VOLUME controller

bm SYS SETTING button

bn ARPEGGIO button

bo PIANO button

bp ELEC PIANO button

bq ORGAN button

br STRINGS/BRASS button

bs GUITAR/BASS button

bt SYNTH/VARIOUS button

ck DRUMS button

cl HEX LAYER button

cm EFFECT, SONG button

cn DSP, REW button

co SYSTEM, FF button

cp MASTER, PAUSE button

cq PHRASE button

cr START/STOP button

cs RECORD button

ct TEMPO, TAP button

dk ZONE/PART/STEP/TRACK, –/+ buttons

Display

dl BANK, INITIALIZE button

dm 0, DELETE button

dn 1, INSERT button

do 2 button

dp 3 button

dq 4 button

dr EXIT button

ds 5, u button

dt 6, w button

ek 7, q button

el 8, i button

em 9, ENTER button

en NUM KEY button

eo –/NO, +/YES buttons

ep EDIT button

eq WRITE button

er AUDIO RECORDER, MEDIA button

es USB flash drive port

et USB port

fk DAMPER/PEDAL1, PEDAL2 jacks

fl MIDI OUT/THRU, IN terminals

fm LINE OUT R, L/MONO jacks

fn DC 12V terminal

fo LINE IN R, L/MONO jacks

fp PHONES jacks

fq AUDIO IN jack
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Before using this Digital Piano for the first time, be sure 
to read the separate USER’S GUIDE (Basics) to 
familiarize yourself with basic operations.

When turning on power, make sure neither of the 
pedals (connected to Pedal 1 and/or Pedal 2) is 
depressed when you press the bk (P) button. Turning 
on power while a pedal is depressed may cause 
problems with effects.
• If you experience such problems, turn off power, 

make sure a pedal is not depressed, and turn power 
back on again.

If you should ever get a “WriteError” (data write error) 
message on the display when you try to save data in 
Digital Piano memory, make a note of the numeric 
code displayed in the message. The code indicates the 
cause of the error and what you need to do to correct it.

Read the Separate USER’S 
GUIDE (Basics) !

Power On Precaution!

“WriteError” Message

Code Cause Action

–4 Battery power 
is low.

• Connect the AC adaptor.
• Replace the batteries.

–1, –2, –3, 
–5, –6

Data writing 
failed for 
some reason.

• Try saving the data again.
• Return the Digital Piano to its 

initial factory default settings.
Important!
Your user data will be deleted 
when you return the Digital 
Piano to its initial factory 
default settings.
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The tones of this Digital Piano are made up of the 16 parts shown below, plus externally input parts.

■ Relationship between Zones, Parts, and Tones

Zone, Part, MIDI Receive Channel, and Tone Relationships

Part Name
Part 

Number

Selectable Tone Categories MIDI Receive 
from External 

Source 
(page E-39)

Song 
SequencerPiano

Melody 
Tones

Drum Sounds Hex Layer

Zone Part 1* 01 O O O O O O

Zone Part 2 02 O O – O O O

Zone Part 3 03
O O – – O O

Zone Part 4 04

- - - 05 - 16 O O O – O O

External Input –
–
Sound input via fo (LINE IN R, L/MONO) and fq (AUDIO IN) on the back of the 
Digital Piano (page E-36)

* About zones and zone parts
Keyboard, pedal, button, and other operations not only affect the Digital Piano’s tones, they are also sent as 
MIDI data and affect any external device (electronic musical instrument or computer) connected to the Digital 
Piano. Because of this, parameter setting areas called “zones” are used to configure common settings for 
internal and external use. The sound source parts inside the Digital Piano are called “zone parts”. For example, 
if you select a tone for the Digital Piano’s Zone 2, that tone is used for the internal sound source’s Zone 2 and 
for the part that corresponds to MIDI Channel 2 of the external device.
• You can change the relationships between zones and MIDI data send channels, if you want (page E-31).

You can perform using four tones at the same time. You also can use “stage setups” to register tone, phrase 
sequencer, and other Digital Piano setups for quick and simple recall while you are performing.

Zone Part 1 Zone Part 2 Zone Part 3 Zone Part 4

(MIDI 
Channel 1)

(MIDI 
Channel 2)

(MIDI 
Channel 3)

(MIDI 
Channel 4)

Zone 1 
Setting

Zone 2 
Setting

Zone 3 
Setting

Zone 4 
Setting

Digital Piano Internal Sound Source

External Device
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Data Configuration and Relationships

100 × User

Stage Setting Copy

Link

1 × Temporary

Stage Setting

Common

Zone1

Tone Hex Layer Drum Set

Arpeggio Phrase#

Zone2

Tone Hex Layer

Arpeggio Phrase#

Song

Track1 Phrase# Phrase# Phrase# Phrase#

Track2 Phrase# Phrase# Phrase# Phrase#

Track8 Phrase# Phrase# Phrase# Phrase#

Cell1 Cell2 Cell3 Cell999

Zone4

Tone

Arpeggio Phrase#

180 × User / 300 × Preset

Tone

DSP

150 × User / 50 × Preset

Hex Layer

DSP

100 × User / 100 × Preset

Arpeggio

20 × User / 20 × Preset

Drum Set

DSP

Phrase Sequencer Memory

Phrase
000

Phrase
001

Phrase
002

Phrase
999 (Max)

10 × User

Zone3

Tone

Arpeggio Phrase#
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In the case of an internal sound source, various types of editing can be performed to create sounds by selecting a 
DSP, configuring DSP settings, editing tones, etc. The signals following tone creation are collected together and then 
output via equalizers that enable adjustment using common master effects.

Tone 
Generator

LINE IN

AUDIO IN

Tone 
Generator

LINE OUT

DSP

Part1-4

Part5-16

String 
Resonance

Damper 
Resonance

System 
Chorus

System 
Delay

System 
Reverb Master 

EQ
Master 

Compressor

Master 
EQ

Master 
Compressor

Resonance 
On/Off

Chorus Send Mono

Stereo

Chorus ReturnResonance 
Return

Volume

Chorus Send

Delay Send

Reverb Send

Volume/Pan

String 
Resonance 
Send

Damper 
Resonance 
Send

Comp position
Pre EQ / Post EQ

Chorus sent to Reverb

Delay sent to Reverb

Reverb Return

Chorus sent to Delay

Delay Return

Delay Send

Reverb Send

Volume

Master Volume

Pre DSP Pan
(Only Pan 
Position= Pre’)

’

Post DSP Pan 
(Only Pan 
Position= Post’)

’

*1 Pre DSP Pan can be used only 
when the DSP Pan Position is 
“Pre”.

*2 Post DSP Pan can be used 
only when the DSP Pan 
Position is “Post”.

*2*1
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You can use controllers (pedals, wheels, knobs, and 
sliders) to instantly change the pitch and volume of 
notes, the envelope, and other parameters as you 
perform (page E-34).
• Two targets can be specified for a single controller.

For example, configuring the settings below would 
make it possible to change the balance between 
layers with a single slider.

Using a Pedal

You can configure a pedal so depressing it sustains a 
tone, applies a softening effect, or to change parameters 
assigned to the pedal.
• The pedal can be configured so its on/off status 

causes gradual increase or decrease of sound 
volume. For more information, see “On Rate” and 
“Off Rate” (page E-35).

• You can specify the effect applied by selecting the 
following in the Stage Setup Editable Parameters: 
Pedal1-2 Edit > Ent. See page E-35 for more 
information.

Using the Bender Wheel

The 1 (BENDER) wheel can be configured so it 
seamlessly raises or lowers the pitch of notes whenever 
it is rotated.

• 1 (BENDER) wheel operation can change pitch 
only within the bend range.

• You can configure the bend range of the 1 
(BENDER) wheel by configuring the following 
settings in the Stage Setup Editable Parameters: 
“Bend Range Down”, “Bend Range Up” (page E-32).

Using the Modulation Wheel, Knobs and 
Sliders

A 2 (MODULATION) wheel, 3 knobs (K1 through 
K4), and 4 sliders (S1) through 9 (S6) can be used to 
adjust volume, effects, the elements that make up 
tones, and other factors.

• You can specify the effect assigned to each of these 
controllers using the Stage Setup Editable 
Parameters shown below. See page E-35 for more 
information.
2 (MODULATION): Modulation Edit > Ent
3 (K1 - K4): Knob1-4 Edit > Ent
4-9 (S1 - S6): Slider1-6 Edit > Ent

Controlling Sounds

1) Select Layer 1 Volume as Target 1 of Slider 1 
(page E-35), and specify a minimum value (Min 
Value) of 0 and a maximum value (Max Value) 
of 127.

2) Select Layer 2 Volume as Target 2 of Slider 1, 
and specify a minimum value (Min Value) of 127 
and a maximum value (Max Value) of 0.

Raises or lowers pitch. 
The wheel returns to its neutral 
position automatically when 
released.

2

3

4 5 6 7 8 9
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Operations Common to All Modes (Tutorial)

When performing editing screen operations and 
configuring system settings, you can use the knobs to 
move the cursor around the screen and to input 
numbers, values, etc.

To move the cursor

1. Rotate 3 (K1) knob.

To input a number, value, or letter

1. Rotate 3 (K2) knob.

• On the arpeggio step editing screen (see “Editing an 
Arpeggio” on page E-25), the four knobs control the 
settings shown below.

• With the song sequencer, the four knobs correspond 
to the settings shown below.

3

Using the Knobs for Input

3 (K1) knob

3 (K2) knob

3 (K3) knob

3 (K4) knob

3 (K1) knob 3 (K3) knob

3 (K2) knob 3 (K4) knob

Download from Www.Somanuals.com. All Manuals Search And Download.



E-10

Using Built-in Tones (Tutorial)

You can use the editing procedures explained in this 
section to edit tones and apply effects as desired. After 
editing a tone, you can give it a name and save it as a 
user tone.
• For information about tone editing, see “To edit a 

tone” (page E-10).
• For information about applying an effect (DSP and/

or system effect) to a tone, see “Applying Effects to 
Notes” (page E-18).

• To change the effects and/or functions assigned to 
wheel, knob, and slider operations, see “Using the 
Stage Setups (Tutorial)” (page E-31).

1. Specify the number of the tone you want to 
edit.

2. Press the ep (EDIT) button.
This displays the editing screen.

3. Use the dt (w) and ek (q) buttons to select 
“Tone”, and then press the em (ENTER) 
button.

4. Use the ds (u), dt (w), ek (q), and el 
(i) buttons to select a setting item.
• If “>ENT” is on the display, it means that there are 

more setting items that can be edited in the operation 
you are performing. In this case, pressing the em 
(ENTER) button will advance to the next editing 
page.

• The setting items that appear on the editing screen 
depend on the tone you select.

• For information about editable parameters, see the 
explanations about each tone category from “Editable 
Melody Tone Parameters” (page E-11) through 
“Editable Hex Layer Tone Parameters” (page E-14).

5. Change parameters as desired.

6. After you finish with your edits, press the dr 
(EXIT) button.
• Press the dr (EXIT) button as many times as required 

to return to the screen where you were before you 
started editing.

1. Perform steps 1 through 3 of the procedure 
under “To edit a tone”, above.

2. Use the ds (u), dt (w), ek (q), and el 
(i) buttons to select “NameEdit”, and then 
press the em (ENTER) button.

3. Change the name.

4. After you finish with your edits, press the dr 
(EXIT) button.
• Press the dr (EXIT) button as many times as required 

to return to the screen where you were before you 
started editing.

4 5 6 7 8 9

3

cn co cpcm dk dt ek emdr ep

en

elds

To edit a tone

To change the name of a tone
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Editable Parameters
• Shaded cells indicate a group made up of multiple setting items. Pressing the em (ENTER) button displays the 

setting items of that group.

■ Editable Melody Tone Parameters

Display Text Description Settings

Pitch >Ent

Pitch envelope. The editable parameters in this group affect the pitch of 
notes.
• The figure below also applied to filter, amp, and other envelopes. 

With the pitch envelope, the pitch of the sound corresponds to the 
vertical (Level) axis.

• With a hex layer tone envelope, Decay Time can be divided into three 
parts and Release Time can be divided into two parts and edited.

• When Decay Level 3 is reached during key release note on, an 
immediate transition is made to Release Level 1 without sustain.

• The setting ranges of the parameters below are relative changes 
(relative to the presets of the tone) in the case of melody tones and 
drum tones. When editing a hex layer tone, they are absolute changes 
that have no relation to the presets of the tone.
– Time and level of each envelope
– Rate, depth, delay, rise, modulation depth of LFO (page E-12)

Octave Shift Octave shift. Changes the tone of notes in octave units. –2 - 0 - +2

Initial Level Initial level. Pitch of the sound at initial note on. –64 - 0 - +63

Attack Time
Attack time. Time it takes until the attack level is reached from the 
initial level.

–64 - 0 - +63

Release Time
Release time. Time it takes to reach Release Level after a key is 
released.

–64 - 0 - +63

Release Level Release level. Target level reached immediately after a key is released. –64 - 0 - +63

Stretch Tune
Stretch tuning. Sharpens high notes and flattens low notes to achieve 
stretch tuning. Turn off this setting to play with normal (non-stretch) 
tuning.

Off, Piano1, Piano2, 
Piano3, Piano4, Piano5, 
E.Piano1, E.Piano2

Filter >Ent

Filter. This is a group of editable parameters associated with filters 
(tones).
• With this group, the vertical (Level) axis in the pitch envelope 

diagram corresponds to how the filter is applied.
• For details about the setting items below, see “Pitch Envelope”.

Initial Level, Attack Time, Release Time, Release Level

Cutoff Cutoff frequency. Specifies the filter cutoff frequency. –64 - 0 - +63

IL

AL

DL1

DL2 DL3 RL1

RL2

AT DT1 DT3DT2 RT1 RT2

Level

Time
DT RT

DL

RL

IL : Initial Level RT : Release Time
AT : Attack Time (RT1: Release Time 1)
AL
DT

: Attack Level (RT2: Release Time 2)
: Decay Time RL : Release Level

(DT1: Decay Time 1) (RL1: Release Level 1)
(DT2: Decay Time 2) (RL2: Release Level 2)
(DT3: Decay Time 3)
DL : Decay Level
(DL1: Decay Level 1)
(DL2: Decay Level 2)
(DL3: Decay Level 3)
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Resonance
Resonance. Specifies the degree of cutoff of the tone in the vicinity of 
the cutoff frequency.

–64 - 0 - +63

Velocity Sense
Velocity sense. Specifies the degree of change in the filter in accordance 
with change in keyboard playing touch.

–64 - 0 - +63

Envelope Depth Envelope depth. Specifies how the envelope is applied. 0 - 127

Attack Level Attack level. Target level reached immediately after note on. –64 - 0 - +63

Decay Time
Decay time. Time it takes for the sound to reach the decay level from 
the attack level.

–64 - 0 - +63

Decay Level
Decay level. Level the sound is sustained as long as a key or pedal is 
depressed.

–64 - 0 - +63

Amp >Ent

Amp. This is a group of editable parameters associated with the amp 
(volume).
• The vertical (Level) axis in the pitch envelope diagram corresponds 

to the volume in the case of this group.
• For details about the setting items below, see “Pitch Envelope”.

Initial Level, Attack Time, Release Time
• For details about the setting items below, see “Filter”, above.

Attack Level, Decay Time, Decay Level

Volume Volume. Specifies the amp volume. 0 - 127

Velocity Sense
Velocity sense. Specifies the degree of change in volume in accordance 
with change in keyboard playing touch.

–64 - 0 - +63

Effect >Ent
Effect. This is a group of editable effect function parameters. For 
details, see “Applying Effects to Notes” (page E-18).

DSP Edit >Ent
DSP edit. This is a group of editable effect function DSPs (page E-18).
Press the em (ENTER) button to advance to the DSP editing screen 
(page E-18).

Chorus Send Chorus send. Specifies how chorus (page E-18) is applied to a tone. 0 - 127

Delay Send Delay send. Specifies how delay (page E-18) is applied to a tone. 0 - 127

Reverb Send Reverb send. Specifies how reverb (page E-18) is applied to a tone. 0 - 127

LFO >Ent
LFO. This is a group of editable LFO parameters applied to pitch, filter, 
and amp.

Pitch Wave
FilterAmpWave

Wave type. Specifies one of the following wave types to be used for 
LFO.
FilterAmpWave is shared by filter and amp.

Refer to the cell to the left.

Pitch Rate
FilterAmpRate

Rate. LFO speed (frequency). FilterAmpRate is shared by filter and 
amp.

–64 - 0 - +63

Pitch Depth
Filter Depth
Amp Depth

Depth. Specifies how LFO is applied. –64 - 0 - +63

Pitch Delay
Filter Delay
Amp Delay

Delay. Specifies the degree of delay in the timing for applying LFO. –64 - 0 - +63

Display Text Description Settings

Sin 
(sine wave)

Puls 1:3 
(square wave 1:3)

Tri 
(triangle wave)

Puls 2:2 
(square wave 2:2)

Saw up 
(sawtooth up 
wave)

Puls 3:1 
(square wave 3:1)

Saw down 
(sawtooth down 
wave)
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■ Editable Drum Tone Parameters

Pitch Rise
Filter Rise
Amp Rise

Rise. Specifies the time it takes from the start of application of the LFO 
until the effect reaches the level specified by Depth, above.

–64 - 0 - +63

Pitch Mod.Depth
Filter Mod.Depth
Amp Mod.Depth

Modulation depth. Specifies how modulation is applied to the LFO. –64 - 0 - +63

Pan >Ent
Pan. This is a group of editable parameters associated with the panning 
(sound stereo position).

Dynamic Panning
Dynamic panning. To reflect changes in panning in the sound being 
produced, select “On” for this setting. Select “Off” if you do not want 
changes reflected.

Off, On

Pan Position
Panning position. Select “PreDSP” to apply panning before the DSP, or 
“PostDSP” to apply panning after the DSP.

PreDSP, PostDSP

Display Text Description Settings

Inst Edit >Ent

Instrument edit. This is a group of editable instruments assigned to 
each keyboard.
• Press a keyboard key to specify the key to be edited.
• For details about “DSP Edit”, see “Applying Effects to Notes” (page 

E-18).

C- - G9

Inst Select
Instrument number select. Specifies the number of the drum tone 
assigned to each key.

See “Instrument List” at 
the back of this manual.

Note Off Mode
Note off mode. Turning on this setting causes note off to be performed 
when a key is released.

Off, On

Assign Group
Assign group. Specifies as a value from 1 to 15 which group the 
currently selected key should be placed into. Only one keyboard in a 
group is sounded at the same time (non-polyphonic).

Off, 1 - 15

Pitch >Ent

Pitch envelope. For details, see the melody tone “Pitch Envelope” on 
page E-11.
• For details about the setting items below, see the melody tone “Pitch 

Envelope” on page E-11.
Initial Level, Attack Time

Coarse 
Tune

Coarse tune. Changes the pitch of notes by semitone units. –24 - 0 - +24

Fine Tune
Fine tune. Fine tunes the pitch of the sound. Lowers the value up to 
–256 or raises the value up to +255 in semitone steps.

–256 - 0 - +255

Filter >Ent

Filter. For details, see the melody tone “Filter” on page E-11.
• For details about the setting items below, see the melody tone 

“Filter” on page E-11.
Cutoff, Resonance, Envelope Depth, Attack Level, Decay Time, 
Decay Level

• For details about the setting items below, see the melody tone “Pitch 
Envelope” on page E-11.
Initial Level, Attack Time

Amp >Ent

Amp. For details, see the melody tone “Amp” on page E-12.
• For details about the setting items below, see the melody tone 

“Amp” on page E-12.
Volume

• For details about the setting items below, see the melody tone “Pitch 
Envelope” on page E-11.
Initial Level, Attack Time

• For details about the setting items below, see the melody tone 
“Filter” on page E-11.
Attack Level, Decay Time, Decay Level

Display Text Description Settings
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■ Editable Hex Layer Tone Parameters
Hex Layer tones have two types of editable parameters: parameters for each of the individual layers (Layer 1 
through Layer 6) and parameters that affect all six of the layers.
• The six sliders (4 to 9) and four knobs (3) can be used for quick and easy adjustment of certain settings using 

the setting items shown below (page E-8).

Editable Parameters for Individual Layers (Layer 1 through Layer 6)

1. Select “Layer Edit >Ent” and then press the em (ENTER) button to enter the group.

2. Use the dk (PART) minus (–) and plus (+) buttons to select the layer number you want to edit.

• When “ALL” (all layers) is selected as the layer number, an x-mark may be displayed on the left side of the display 
showing the part being edited. This indicates that all of the layers do not have the same setting for the currently selected 
parameter.

Pan Pan. Specifies the stereo position of drum sound. –64 - 0 - +63

Effect >Ent

Effect. This is a group of editable effect function DSPs (page E-18). 
Press the em (ENTER) button to advance to the DSP editing screen.
• For details about the setting items below, see the melody tone 

“Effect” on page E-12.
Chorus Send, Delay Send, Reverb Send

• Values produced by multiplying send values configured for 
instrument-specific effects (Effect >Ent) and send values configured 
for global effects (Common Effect >Ent) are batch sent to the system.

• When “DSP On/Off” is turned on (DSP applied), chorus, delay, and 
reverb settings can be configured within “Common Effect >Ent” 
below.

DSP 
On/Off

DSP on/off. Specifies whether or not DSP should be applied to tones. Off, On

Common Effect >Ent

Common effect. This is a group of editable effect function parameters. 
For details, see the melody tone “Effect” on page E-12.
• For details about the setting items below, see the melody tone 

“Effect” on page E-12.
Chorus Send, Delay Send, Reverb Send

Pan >Ent

Pan. This is a group of editable parameters associated with panning 
(sound stereo position).
• For details about the setting items below, see the melody tone “Pan” 

on page E-13.
Dynamic Panning, Pan Position

Display Text Description Settings

layer number
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Editable Parameters

Display Text Description Settings

Layer On/Off Layer on/off. Selecting off disables layer. Off, On

Wave Number
Wave number. Selects a waveform type.
• Refer to the “Wave List” at the back of this manual for information 

about wave types.

See “Wave List” at the 
back of this manual.

Pitch >Ent

Pitch envelope. For details, see the melody tone “Pitch Envelope” on 
page E-11.
• For details about the setting items below, see the melody tone “Pitch 

Envelope” on page E-11. You can input “Initial Level” and “Release 
Level” values in the range of –256 to 0 to +255. You can input “Attack 
Time” and “Release Time” values in the range of 0 to 127.
Octave Shift, Initial Level, Attack Time, Release Time, Release Level

• For details about the setting items below, see drum tone “Pitch 
Envelope” on page E-13.
Coarse Tune, Fine Tune

• For details about the setting items below, see the melody tone 
“Filter” on page E-11. You can input “Attack Level” and “Decay 
Level” values in the range of –256 to 0 to +255. You can input a 
“Decay Time” in the range of 0 to 127.
Attack Level, Decay Time, Decay Level

Key Follow
Key follow. Adjusts the amount of pitch change between neighboring 
keyboard keys. A higher value represents greater change.

–128 - 0 - +127

Key Follow Base Key follow base. Keyboard key that is the center of key follow. C- - G9

Split Shift

Split shift. Counting from the keyboard key that is pressed, the 
waveform that sounds is the one assigned to the keyboard key that is 
the specified split shift amount above or below the pressed key. The 
pitch used is the one that corresponds to the pressed keyboard key.

–12 - 0 - +12

LFO Layer Depth LFO layer depth. Adjusts how LFO is applied to each layer. 0 - 127

Filter >Ent

Filter. For details, see the melody tone “Filter” on page E-11.
• For details about the setting items below, see the melody tone 

“Filter” on page E-11. You can input a value in the range from 0 to 
127.
Cutoff, Resonance, Attack Level, Envelope Depth

• For details about the setting items below, see the melody tone “Pitch 
Envelope” on page E-11. You can input a value in the range from 0 to 
127.
Initial Level, Attack Time

Filter Type

Filter type. Specifies the range cut by the filter.
LPF1: 6dB/oct filter for low-frequency band components. No 

resonance effect. Suitable for acoustic instruments.
LPF2: 12dB/oct filter for low-frequency band components. No 

resonance effect. Suitable for acoustic instruments.
LPF3: 12dB/oct filter for low-frequency band components. With 

resonance effect. Suitable for synthesized tones.
BPF : 6dB/oct filter for band components in the vicinity of the cutoff 

frequency. With resonance effect.
HPF : 12dB/oct filter for high-frequency band components. With 

resonance effect.

Refer to the cell to the left.

Velocity Sense
Velocity sense. Specifies the degree of change in the filter in accordance 
with keyboard press velocity.

–64 - 0 - +63

Decay 1 Time
Decay 1 time. Time it takes for the sound to reach the decay 1 level 
from the attack level.

0 - 127

Decay 1 Level
Decay 1 level. Target level for change from the attack level up to the 
Decay 1 level.

0 - 127

Decay 2 Time
Decay 2 time. Time it takes for the sound to reach the Decay 2 level 
from the Decay 1 level.

0 - 127

Decay 2 Level
Decay 2 level. Second target level for change from Decay 1 level up to 
the Decay 2 level.

0 - 127
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Decay 3 Time
Decay 3 time. Time it takes for the sound to reach the Decay 3 level 
from the Decay 2 level.

0 - 127

Decay 3 Level
Decay 3 level. Third target level for change from Decay 2 level up to the 
Decay 3 level.

0 - 127

Release 1 Time
Release 1 time. Time it takes to reach Release Level 1 after a key is 
released.

0 - 127

Release 1 Level
Release 1 level. Target level reached immediately after a key is 
released.

0 - 127

Release 2 Time
Release 2 time. Time it takes to reach Release Level 2 from Release 
Level 1.

0 - 127

Release 2 Level Release 2 level. Second target level reached after a key is released. 0 - 127

Key Follow
Key follow. Adjusts the amount of filter change between neighboring 
keyboard keys. A higher value represents greater change.

–128 - 0 - +127

Key Follow Base Key follow base. Keyboard key that is the center of key follow. C- - G9

LFO Layer Depth LFO layer depth. Adjusts how LFO is applied to each layer. 0 - 127

Amp >Ent

Amp. For details, see the melody tone “Amp” on page E-12.
• For details about the setting items below, see the melody tone 

“Amp” on page E-12.
Volume, Velocity Sense

• For details about the setting items below, see the drum tone “Amp” 
on page E-13.
Pan

• For details about the setting items below, see the melody tone “Pitch 
Envelope” on page E-11. You can input a value in the range from 0 to 
127.
Initial Level, Attack Time

• For details about the setting items below, see the melody tone 
“Filter” on page E-11. You can input a value in the range from 0 to 
127.
Attack Level

• For details about the setting items below, see the hex layer “Filter” on 
page E-15.
Decay 1 Time, Decay 1 Level, Decay 2 Time, Decay 2 Level, 
Decay 3 Time, Decay 3 Level, Release 1 Time, Release 1 Level, 
Release 2 Time

Key Follow
Key follow. Adjusts the amount of volume change between 
neighboring keyboard keys. A higher value represents greater change.

–128 - 0 - +127

Key Follow Base Key follow base. Keyboard key that is the center of key follow. C- - G9

LFO Layer Depth LFO layer depth. Adjusts how LFO is applied to each layer. 0 - 127

Effect >Ent

For details, see the melody tone “Effect” on page E-12.
• For details about the setting items below, see the drum tone “Effect” 

on page E-14.
DSP On/Off

• For details about the setting items below, see the melody tone 
“Effect” on page E-12.
Chorus Send, Delay Send, Reverb Send

• Values produced by multiplying send values configured for 
instrument-specific effects (Effect>Ent) and send values configured 
for global effects (Common Effect>Ent) are batch sent to the system.

• When “DSP On/Off” is turned on (DSP applied), chorus, delay, and 
reverb settings can be configured within “Common Effect >Ent” 
below.

Key Range Low

Key Range Low. Specifies the lower limit of the enabled keyboard 
range. Nothing sounds when any keyboard key below this range is 
pressed.
• After pressing the en (NUM KEY) button to enter the number input 

mode, you can use the keyboard keys to enter values.

C- - G9

Display Text Description Settings
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Editable Parameters for All Layers (Layer 1 through Layer 6)
Editable Parameters
• Shaded cells indicate a group made up of multiple parameters. Press the em (ENTER) button to display the setting items that 

make up a group.

Key Range High

Key Range High. Specifies the upper limit of the enabled keyboard 
range. Nothing sounds when any keyboard key above this range is 
pressed.
• After pressing the en (NUM KEY) button to enter the number input 

mode, you can use the keyboard keys to enter values.

C- - G9

VelocityRangeLow
Velocity range low. Specifies the minimum value of the effective 
velocity. No sound is produced when playing at a velocity less than 
this setting.

0 - 127

VelocityRangeHigh
Velocity range high. Specifies the maximum value of the effective 
velocity. No sound is produced when playing at a velocity greater than 
this setting.

0 - 127

Start Trigger
Start trigger. Specifies whether a note is sounded when a keyboard key 
is pressed (KeyOn) or when a keyboard key is released (KeyOff).

KeyOn, KeyOff

Display Text Description Settings

Init By Wave
Parameter initialization by wave selection. Select “On” to link the 
envelope and other parameters when the wave changes or “Off” not to 
link.

Off, On

Volume Volume. Overall hex layer volume. 0 - 127

Common Effect >Ent

Common Effect. This is a group of editable effect function parameters. 
For details, see the melody tone “Effect” on page E-12.
• For details about the setting items below, see the melody tone 

“Effect” on page E-12.
Chorus Send, Delay Send, Reverb Send

LFO >Ent

LFO. This is a group of editable LFO parameters applied to the pitch of 
a layered tone. For details, see the melody tone “LFO” on page E-12.
• For details about the setting items below, see the melody tone “LFO” 

on page E-12. You can input a value in the range from 0 to 127.
Pitch Rate, Pitch Delay, Pitch Rise, Pitch Mod.Depth*, Filter Amp 
Rate, Filter Delay, Filter Rise, Filter Mod.Depth*, Amp Delay, Amp 
Rise, Amp Mod.Depth*
* Performs same operation as the melody tone setting range (–64 to 0 

to +63).
• For details about the setting items below, see the melody tone “LFO” 

on page E-12. Note, however, that the setting ranges of Pitch Depth, 
Filter Depth, and Amp Depth are –128 to 0 to +127.
Pitch Wave, Filter Amp Wave, Pitch Depth, Filter Depth, Amp Depth

Detune

Detune. Causes the tuning of Layers 1 through 6 to be slightly different 
from each other. A larger setting value increases the amount of 
detuning. The maximum value (31) results in a difference of 100 cents 
(semitones) between Layer 1 and Layer 6.

0 - 31

Display Text Description Settings

Detune = 31

+50cent

−50cent

Detune = 0
Layer2 Layer3Layer1

Layer6Layer5Layer4
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Pitch Lock 1-2
Pitch Lock 3-4
Pitch Lock 5-6

Pitch lock. When this setting is turned on for Layer 2, the Layer 2 pitch 
is changed to the same pitch as Layer 1 so both pitches are the same. 
The same is true for Layers 3 and 4, and Layers 5 and 6.

Off, On

Stretch Tune For details, see the melody tone “Stretch Tune” on page E-11.

KeyOffVel.Mode
Key off velocity mode. Select “KeyOff” to use the key off velocity as the 
key off velocity, or “KeyOn” to select the key on velocity. Select “Both” 
to reflect both (key on and key off) velocities.

KeyOff, KeyOn, Both

Pan >Ent

Pan. This is a group of editable parameters associated with panning 
(sound stereo position). For details, see the melody tone “Pan” on page 
E-13.
• For details about the setting items below, see the melody tone “Pan” 

on page E-13.
Dynamic Panning, Pan Position

Display Text Description Settings

Your Digital Piano has three types of effects, each of 
which includes the effects described below.

A) Digital Signal Processor (DSP)
A collection of versatile DSP effects help to enhance the 
sound of tones. For example, distortion can be applied 
to an electric guitar sound to make it sound more 
powerful. There are 20 different DSP types, and the 
most appropriate one for the selected tone is applied 
automatically.

B) System Effects (SYSTEM)
These effects are shared by all Digital Piano parts. The 
depth of an effect can be adjusted by specifying the 
send level from the part to each system effect.
• Chorus (System Chorus): Combines multiple layers 

of the same note to create a sound with more depth.
• Delay (System Delay): Delays the input signal and 

feeds it back to create a repeating effect and give 
notes more breadth.

• Reverb (System Reverb): Adds reverberation to 
make it sound like you are playing in a room or in a 
hall.

• Resonance (System Resonance): Simulates the 
resonance of acoustic piano strings. 
String Resonance (String Reso): Generates resonance 
for the strings of keys being pressed. 
Damper Resonance (Damper Reso): Generates string 
resonance when the damper pedal is pressed. 
Note that use of string resonance and damper 
resonance is supported only for certain tones.*

C) Master Effects (MASTER)
These effects process the Digital Piano master output 
signal.
• Equalizer (Master Equalizer (EQ)): Adjusts the 

master frequency characteristics. The Master 
Equalizer can be used to adjust the frequency and 
gain of four frequency bands: low, mid1, mid2, and 
high.

• Compressor (Master Compressor): Compresses the 
instrument master output signal. This effect can be 
used to suppress level dispersion and limit the level 
of the input signal so it does not exceed the setting 
value.

Applying Effects to Notes

* Tones for which the “Reso.Return Level” mixer 
parameter (page E-32) setting can be configured.

Download from Www.Somanuals.com. All Manuals Search And Download.



Using Built-in Tones (Tutorial)

E-19

To apply an effect to a tone

1. Select the tone to which you want to apply the 
effect.

2. Press the cm (EFFECT, SONG) button as 
many times as necessary until the indicator 
lamp on the EFFECT side is lit.

3. Press one of the buttons below, depending 
on the type of effect you want to apply.

A) DSP: cn (DSP) button
B) SYSTEM: co (SYSTEM) button
C) MASTER: cp (MASTER) button

This displays an effect setting screen. The screenshot 
below shows the screen when configuring SYSTEM 
settings.

• A button lamp will not light when you press the cn 
(DSP), co (SYSTEM), or cp (MASTER) button.

• To find out whether an effect is on or off, check the 
effect type and setting.

• The effect screen can also be displayed from the stage 
setup editing screen (page E-31).

4. Use the ds (u), dt (w), ek (q), and el 
(i) buttons to select a setting item.
• For details about editable parameters, see “Editable 

DSP Parameters”, “Editable SYSTEM Parameters”, 
and “Editable MASTER Parameters”, starting from 
page E-19.

• If “>ENT” is on the display, it means that there are 
more parameters that can be edited in the operation 
you are performing. In this case, pressing the em 
(ENTER) button will advance to the next editing 
page.

5. Change parameters as desired.

6. After you finish with your edits, press the dr 
(EXIT) button.
• Press the dr (EXIT) button as many times as required 

to return to the screen where you were before you 
started editing.

Temporarily Bypassing the DSP

Use the procedure below to temporarily bypass the 
DSP and switch the currently selected zone tone to one 
without the DSP effect applied.
• You can bypass the DSP for each tone of each zone.

1. Hold down the cn (DSP) button until its lamp 
flashes.

2. To cancel the bypass, hold down the cn 
(DSP) button again until its lamp goes out.
• Note that bypass is canceled even if you change to a 

different stage setup.

■ Editable DSP Parameters
• Select “Through” if you want to disable application 

of DSP.
• You can select different DSP effects for Parts 1 

through 4.
• Parts 5 through 16 do not support use of DSP effects.

- -: Through
Select this option if you do not want to apply a DSP effect. There are 
no parameters that can be set while this option is selected.

01: Equalizer
This is a three-band equalizer.
Parameter Value Ranges:
1 :EQ1 Frequency (1.0k, 1.3k, 1.6k, 2.0k, 2.5k, 3.2k, 4.0k, 5.0k [Hz])

Adjusts the center frequency of Equalizer 1.
2 :EQ1 Gain (–12 to 0 to +12)

Adjusts the gain of Equalizer 1.
3 :EQ2 Frequency (1.0k, 1.3k, 1.6k, 2.0k, 2.5k, 3.2k, 4.0k, 5.0k [Hz])

Adjusts the center frequency of Equalizer 2.
4 :EQ2 Gain (–12 to 0 to +12)

Adjusts the gain of Equalizer 2.
5 :EQ3 Frequency (1.0k, 1.3k, 1.6k, 2.0k, 2.5k, 3.2k, 4.0k, 5.0k [Hz])

Adjusts the center frequency of Equalizer 3.
6 :EQ3 Gain (–12 to 0 to +12)

Adjusts the gain of Equalizer 3.
7 :Input Level (0 to 127)

Adjusts the input level.
8 :Wet Level (0 to 127)

Adjusts the level of the effect sound.
9 :Dry Level (0 to 127)

Adjusts the level of the direct sound.

Note: The Gain value is not a dB value.
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02: Compressor
Compresses the input signal, which can have the effect of 
suppressing level variation and can make it possible to sustain 
dampened sounds longer.
Parameter Value Ranges:
1 :Attack (0 to 127)

Adjusts the attack amount of the input signal. A smaller value 
causes prompt compressor operation, which suppresses the attack 
of the input signal. A larger values delays compressor operation, 
which causes the attack of the input signal to be output as-is.

2 :Release (0 to 127)
Adjusts the time from the point the input signal drops below a 
certain level until the compression operation is stopped.
When an attack feeling is desired (no compression at the onset of 
sound), set this parameter to as low a value as possible. To have 
compression applied at all times, set a high value.

3 :Depth (0 to 0 to 127)
Adjusts compression of the audio signal.

4 :Wet Level (0 to 127)
Adjusts the level of the effect sound.
Output volume changes in accordance with the Depth setting and 
the characteristics of the input tone.

5 :Dry Level (0 to 127)
Adjusts the level of the direct sound.

03: Limiter
Limits the input signal level so it does not rise above a preset level.
Parameter Value Ranges:
1 :Limit (0 to 127)

Adjusts the volume level of the limit at which limiting is applied.
2 :Attack (0 to 127)

Adjusts the attack amount of the input signal.
3 :Release (0 to 127)

Adjusts the time from the point the input signal drops below a 
certain level until the limit operation is stopped.

4 :Wet Level (0 to 127)
Adjusts the level of the effect sound. Output volume changes in 
accordance with the Limit setting and the characteristics of the 
input tone. Use this parameter to correct for such changes.

5 :Dry Level (0 to 127)
Adjusts the level of the direct sound.

04: Enhancer
Enhances the profiles of the low range and high range of the input 
signal.
Parameter Value Ranges:
1 :Low Frequency (0 to 127)

Adjusts the low range enhancer frequency.
2 :Low Gain (0 to 127)

Adjusts the low range enhancer gain.
3 :High Frequency (0 to 127)

Adjusts the high range enhancer frequency.
4 :High Gain (0 to 127)

Adjusts the high range enhancer gain.
5 :Input Level (0 to 127)

Adjusts the input level.
6 :Wet Level (0 to 127)

Adjusts the level of the effect sound.
7 :Dry Level (0 to 127)

Adjusts the level of the direct sound.

05: Early Reflection
An effector that extracts early reflections from reverb.
Applies acoustic presence to notes.
Parameter Value Ranges:
1 :Wet Level (0 to 127)

Adjusts the level of the effect sound.
2 :Feedback (0 to 127)

Adjusts the repeat of the reflected sound.
3 :Tone (0 to 127)

Adjusts the tone of the reflected sound.
4 :Input Level (0 to 127)

Adjusts the input level.
5 :Dry Level (0 to 127)

Adjusts the level of the direct sound.

06: Phaser
Produces a distinctive pulsating, broad sound by using an LFO to 
change the phase of the input signal and then mixes it with the 
original input signal.
Parameter Value Ranges:
1 :Resonance (0 to 127)

Adjusts the strength of feedback
2 :Manual (–64 to 0 to +63)

Adjusts the reference phaser shift amount.
3 :LFO Rate (0 to 127)

Adjusts the LFO rate.
4 :Depth (0 to 127)

Adjusts the LFO depth.
5 :LFO Waveform (Sin, Tri, Random)

Selects the LFO waveform.
6 :Input Level (0 to 127)

Adjusts the input level.
7 :Wet Level (0 to 127)

Adjusts the level of the effect sound.
8 :Dry Level (0 to 127)

Adjusts the level of the direct sound.

07: Chorus
Gives notes depth and breadth.
Parameter Value Ranges:
1 :LFO Rate (0 to 127)

Adjusts the LFO rate.
2 :Depth (0 to 127)

Adjusts the LFO depth.
3 :LFO Waveform (Sin, Tri)

Selects the LFO waveform.
4 :Feedback (–64 to 0 to +63)

Adjusts the strength of feedback
5 :Wet Level (0 to 127)

Adjusts the level of the effect sound.
6 :Polarity (–, +)

Inverts the LFO of one channel.
7 :Input Level (0 to 127)

Adjusts the input level.
8 :Dry Level (0 to 127)

Adjusts the level of the direct sound.

08: Flanger
Applies wildly pulsating and metallic reverberation to notes. Selects 
the LFO waveform.
Parameter Value Ranges:
1 :LFO Rate (0 to 127)

Adjusts the LFO rate.
2 :Depth (0 to 127)

Adjusts the LFO depth.
3 :LFO Waveform (Sin, Tri, Random)

Selects the LFO waveform.
4 :Feedback (–64 to 0 to +63)

Adjusts the strength of feedback
5 :Wet Level (0 to 127)

Adjusts the level of the effect sound.
6 :Input Level (0 to 127)

Adjusts the input level.
7 :Dry Level (0 to 127)

Adjusts the level of the direct sound.

09: Tremolo
Shifts the volume of the input signal using an LFO.
Parameter Value Ranges:
1 :LFO Rate (0 to 127)

Adjusts the LFO rate.
2 :Depth (0 to 127)

Adjusts the LFO depth.
3 :LFO Waveform (Sin, Tri, Tra)

Selects the LFO waveform.
4 :Wet Level (0 to 127)

Adjusts the level of the effect sound.
5 :Dry Level (0 to 127)

Adjusts the level of the direct sound.
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10: Auto Pan
Shifts the continual left-right panning of the input signal using an 
LFO.
Parameter Value Ranges:
1 :LFO Rate (0 to 127)

Adjusts the LFO rate.
2 :Depth (0 to 127)

Adjusts the LFO depth.
3 :LFO Waveform (Sin, Tri, Tra)

Selects the LFO waveform.
4 :Manual (–64 to 0 to +63)

Adjusts the pan (stereo position). –64 is full left, 0 is center, and 
+63 is full right.

5 :Wet Level (0 to 127)
Adjusts the level of the effect sound.

6 :Dry Level (0 to 127)
Adjusts the level of the direct sound.

11: Rotary
This effect is a rotary speaker simulator.
Parameter Value Ranges:
1 :Speed (Slow, Fast)

Switches the speed mode between fast and slow.
2 :Brake (Rotate, Stop)

Stops speaker rotation.
3 :Fall Accel (0 to 127)

Adjusts acceleration when the speed mode is switched from fast 
to slow.

4 :Rise Accel (0 to 127)
Adjusts acceleration when the speed mode is switched from slow 
to fast.

5 :Slow Rate (0 to 127)
Adjusts the speaker rotation speed in the slow speed mode.

6 :Fast Rate (0 to 127)
Adjusts the speaker rotation speed in the fast speed mode.

7 :Vibrato/Chorus (Off, V1, C1, V2, C2, V3, C3)
Selects the vibrato (V) and the chorus (C) type.

8 :Wet Level (0 to 127)
Adjusts the level of the effect sound.

9 :Dry Level (0 to 127)
Adjusts the level of the direct sound.

12: Drive Rotary
This is a rotary speaker simulator that makes overdrive possible.
Parameter Value Ranges:
1 :Overdrive Gain (0 to 127)

Adjusts overdrive gain.
2 :Overdrive Level (0 to 127)

Adjusts the overdrive output level.
3 :Speed (Slow, Fast)

Switches the speed mode between fast and slow.
4 :Brake (Rotate, Stop)

Stops speaker rotation.
5 :Fall Accel (0 to 127)

Adjusts acceleration when the speed mode is switched from fast 
to slow.

6 :Rise Accel (0 to 127)
Adjusts acceleration when the speed mode is switched from slow 
to fast.

7 :Slow Rate (0 to 127)
Adjusts the speaker rotation speed in the slow speed mode.

8 :Fast Rate (0 to 127)
Adjusts the speaker rotation speed in the fast speed mode.

9 :Vibrato/Chorus (Off, V1, C1, V2, C2, V3, C3)
Selects the vibrato (V) and chorus (C) type.

10 :Wet Level (0 to 127)
Adjusts the level of the effect sound.

11 :Dry Level (0 to 127)
Adjusts the level of the direct sound.

13: LFO Wah
This is a “wah” effect that can automatically affect the frequency 
using an LFO.
Parameter Value Ranges:
1 :Input Level (0 to 127)

Adjusts the input level. The input signal can become distorted 
when the level of the sound being input, the number of chords, or 
the Resonance value is large. Adjust this parameter to eliminate 
such distortion.

2 :Resonance (0 to 127)
Adjusts the strength of feedback

3 :Manual (0 to 127)
Adjusts the wah filter reference frequency.

4 :LFO Rate (0 to 127)
Adjusts the LFO rate.

5 :Depth (0 to 127)
Adjusts the LFO depth.

6 :LFO Waveform (Sin, Tri, Random)
Selects the LFO waveform.

7 :Wet Level (0 to 127)
Adjusts the level of the effect sound.

8 :Dry Level (0 to 127)
Adjusts the level of the direct sound.

14: Auto Wah
This is a “wah” effect that can automatically shift the frequency in 
accordance with the level of the input signal.
Parameter Value Ranges:
1 :Input Level (0 to 127)

Adjusts the input level. The input signal can become distorted 
when the level of the sound being input, the number of chords, or 
the Resonance value is large. Adjust this parameter to eliminate 
such distortion.

2 :Resonance (0 to 127)
Adjusts the strength of feedback

3 :Manual (0 to 127)
Adjusts the wah filter reference frequency.

4 :Depth (–64 to 0 to +63)
Adjusts the depth of the wah in accordance with the level of the 
input signal.
Setting a positive value causes the wah filter to open in direct 
proportion with the size of the input signal, producing a bright 
sound. Setting a negative value causes the wah filter to close in 
direct proportion with the size of the input signal, producing a dark 
sound.

5 :Wet Level (0 to 127)
Adjusts the level of the effect sound.

6 :Dry Level (0 to 127)
Adjusts the level of the direct sound.

15: Distortion
Distortion + Wah + Amp Simulator
Parameter Value Ranges:
1 :Dist Gain (0 to 127)

Adjusts the distortion input signal gain.
2 :Dist Level (0 to 127)

Adjusts the distortion output level.
3 :Dist Low (0 to 127)

Adjusts the distortion low-range gain.
4 :Dist High (0 to 127)

Adjusts the distortion high-range gain.
5 :Wah Depth (–64 to 0 to +63)

Adjusts the depth of the wah in accordance with the level of the 
input signal.

6 :Wah Manual (0 to 127)
Adjusts the wah filter reference frequency.

7 :Routing (Dist, Wah, Wah-Dist, Dist-Wah)
Specifies the distortion and wah connection.

8 :Amp (Bypass, TCombo, FCombo, ACombo, BCombo, JCombo, 
MStack, RStack, BassC, BassS)

Specifies the amp simulation type.
9 :Wet Level (0 to 127)

Adjusts the level of the effect sound.
10 :Dry Level (0 to 127)

Adjusts the level of the direct sound.
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16: Pitch Shifter
This effect transforms the pitch of the input signal.
Parameter Value Ranges:
1 :Pitch (–24 to 0 to +24)

Adjusts the pitch shift amount in quarter tone steps.
2 :High Damp (0 to 127)

Adjusts the high-range damp. A larger number increases 
damping.

3 :Feedback (0 to 127)
Adjusts the feedback amount.

4 :Input Level (0 to 127)
Adjusts the input level.

5 :Wet Level (0 to 127)
Adjusts the level of the effect sound.

6 :Dry Level (0 to 127)
Adjusts the level of the direct sound.

17: Multi Chorus
This is a chorus effect with six different LFO phases.
Parameter Value Ranges:
1 :LFO Rate (0 to 127)

Adjusts the LFO rate.
2 :Depth (0 to 127)

Adjusts the LFO depth.
3 :Wet Level (0 to 127)

Adjusts the level of the effect sound.
4 :Dry Level (0 to 127)

Adjusts the level of the direct sound.

18: Ring Modulator
Multiplies the input signal with an internal oscillator signal to create a 
metallic sound.
Parameter Value Ranges:
1 :OSC frequency (0 to 127)

Sets the reference frequency of the internal oscillator.
2 :LFO Rate (0 to 127)

Adjusts the LFO rate.
3 :Depth (0 to 127)

Adjusts the LFO depth.
4 :Tone (0 to 127)

Adjusts the timbre of the ring modulator input sound.
5 :Wet Level (0 to 127)

Adjusts the level of the effect sound.
6 :Dry Level (0 to 127)

Adjusts the level of the direct sound.

19: Delay
Delays the input signal and feeds it back to create a repeating effect.
Parameter Value Ranges:
1 :Delay Time (0 to 127)

Adjusts the total delay time.
2 :Delay Ratio L (0 to 127)

Adjusts the ratio of the left channel relative to the total delay time.
3 :Delay Ratio R (0 to 127)

Adjusts the ratio of the right channel relative to the total delay 
time.

4 :Delay Level L (0 to 127)
Adjusts the level of the left channel.

5 :Delay Level R (0 to 127)
Adjusts the level of the right channel.

6 :Feedback Type (Stereo, Cross)
Selects the feedback type.
Stereo: Stereo feedback
Cross: Cross feedback

7 :Feedback (0 to 127)
Adjusts the feedback amount.

8 :High Damp (0 to 127)
Adjusts the high-range damp. A larger number increases 
damping.

9 :Delay Tempo Sync (Off, 1/4, 1/3, 3/8, 1/2, 2/3, 3/4, 1)
Specifies how the actual total delay time is synced with tempo.
• Off: Uses Delay Time value.
• 1/4 to 1: Uses value in accordance with number of beats.

10 :Input Level (0 to 127)
Adjusts the input level.

11 :Dry Level (0 to 127)
Adjusts the level of the direct sound.

12 :Wet Level (0 to 127)
Adjusts the level of the effect sound.

20: Piano Effect
This effect is suited to acoustic piano play.
Parameter Value Ranges:
1 :Lid Type (Closed, Semi Opened, Full Opened)

Adjusts how sound resonates in accordance with the opening 
state of a piano lid.

2 :Reflection Level (0 to 127)
Adjusts the level of the initial reflection.

3 :Input Level (0 to 127)
Adjusts the input level.

4 :Wet Level (0 to 127)
Adjusts the level of the effect sound.

5 :Dry Level (0 to 127)
Adjusts the level of the direct sound.
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■ Editable SYSTEM Parameters
• Parts 5 through 16 do not support use of resonance 

effects.

System Chorus
Parameter Value Ranges:
1 :Type (Light Cho, Chorus, FB Chorus, Flanger)

Selects the chorus type.
2 :LFO Rate (0 to 127)

Adjusts the LFO rate.
3 :LFO Depth (0 to 127)

Adjusts the LFO depth.
4 :Feedback (0 to 127)

Adjusts the feedback amount.
5 :Tone (0 to 127)

Adjusts the tone.
6 :Delay Time (0 to 127)

Adjusts the delay time.
7 :Delay Send (0 to 127)

Adjust the send level to system delay.
8 :Reverb Send (0 to 127)

Adjust the send level to system reverb.
9 :Return (0 to 127)

Adjusts the return level.

System Delay
Parameter Value Ranges:
1 :Time (0 to 127)

Adjusts the total delay time.
2 :Feedback (0 to 127)

Adjusts the feedback amount.
3 :High Damp (0 to 127)

Adjusts the high-range damp. A larger number increases 
damping.

4 :Ratio L (0 to 127)
Adjusts the ratio of the left channel relative to the total delay time.

5 :Ratio C (0 to 127)
Adjusts the ratio of the center channel relative to the total delay 
time.

6 :Ratio R (0 to 127)
Adjusts the ratio of the right channel relative to the total delay 
time.

7 :Level L (0 to 127)
Adjusts the level of the left channel.

8 :Level C (0 to 127)
Adjusts the level of the center channel.

9 :Level R (0 to 127)
Adjusts the level of the right channel.

10 :Tempo Sync (Off, 1/4, 1/3, 3/8, 1/2, 2/3, 3/4, 1, 4/3, 3/2, 2)
Specifies how the actual total delay time is synced with tempo.
• Off: Uses Delay Time value.
• 1/4 to 2: Uses value in accordance with number of beats.

11 :Reverb Send (0 to 127)
Adjust the send level to system reverb.

12 :Return (0 to 127)
Adjusts the return level.

System Reverb
Parameter Value Ranges:
1 :Type (Room, Hall1, Hall2, Plate)

Selects the reverb type.
2 :Time (0 to 127)

Adjusts the reverb time.
3 :Early Reflection (0 to 127)

Adjusts the level of the initial reflection.
4 :High Damp (0 to 127)

Adjusts the high-range damp. A larger number increases 
damping.

5 :Tone (0 to 127)
Adjusts the tone.

6 :Return (0 to 127)
Adjusts the return level.

System Resonance
Parameter Value Ranges:
1 :String Reso Send (0 to 15)

Adjusts the send level to string resonance.
2 :Damper Reso Send (0 to 15)

Adjusts the send level to damper resonance.
3 :Damper Noise Enable (Off, On)

Enables/disables the damper noise effect.

■ Editable MASTER Parameters

Master Compressor
Parameter Value Ranges:
1 :Threshold (0 to 127)

Adjusts the threshold (where application of an effect starts) level.
Set a lower value for a compressor effect, and a higher value for a 
limiter effect.

2 :Ratio (0 to 127)
Adjusts the compression ratio.
Set a lower value to for a compressor effect, and the maximum 
value to for a limiter effect.

3 :Level (0 to 127)
Adjusts the output level.

4 :Attack (0 to 127)
Adjusts the time until the compression effect starts.
A smaller value causes prompt compressor operation, which 
suppresses the attack of the input signal. A larger values delays 
compressor operation, which causes the attack of the input signal 
to be output as-is.

5 :Release (0 to 127)
Adjusts the release time.
Adjusts the time until the compression effect is released.

6 :Position (PreEQ, PostEQ)
Selects the connection position with the compressor and EQ.

Master Equalizer
Parameter Value Ranges:
1 :Low Gain (–12 to 0 to +12)

Adjusts the low-range gain.
2 :Low Frequency (200, 400, 800 [Hz])

Selects the low-range cutoff frequency.
3 :Mid 1 Gain (–12 to 0 to +12)

Adjusts the low mid-range gain.
4 :Mid 1 Frequency 

(1.0k, 1.3k, 1.6k, 2.0k, 2.5k, 3.2k, 4.0k, 5.0k [Hz])
Selects the low mid-range frequency.

5 :Mid 2 Gain (–12 to 0 to +12)
Adjusts the high mid-range gain.

6 :Mid 2 Frequency 
(1.0k, 1.3k, 1.6k, 2.0k, 2.5k, 3.2k, 4.0k, 5.0k [Hz])
Selects the high mid-range frequency.

7 :High Gain (–12 to 0 to +12)
Adjusts the high-range gain.

8 :High Frequency (6.0k, 8.0k, 10k [Hz])
Selects the high-range cutoff frequency.

9 :Input Level (0 to 127)
Adjusts the input level.

10 :Output Level (0 to 127)
Adjusts the output level.
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You can edit the Digital Piano’s built-in arpeggios to 
create original arpeggios of your own. You can also 
record your own original musical phrases for playback 
in place of arpeggios. After editing an arpeggio, you 
can give it a name and save it as a user arpeggio.
• The term “key play” means starting playback of a 

phrase by pressing a keyboard key. With key play, 
pressing a keyboard key that is the one specified as 
the phrase’s “ORG NOTE” setting will play back the 
phrase as it was originally recorded. Pressing a 
keyboard key that is not the one specified as the 
phrase’s “ORG NOTE” setting will shift the pitch of 
the phrase in accordance with the key that is 
pressed.

1. Hold down bn (ARPEGGIO) button until the 
arpeggio type selection screen shown below 
appears on the display.
This will cause the button’s lamp to light.

2. Press the ek (q) button.
This will display the target selection screen 
(TARGET:ARPEGGIO).

3. Press the eo plus (+) button.
This will change to the target phrase selection screen 
(TARGET:PHRASE), and display the currently selected 
phrase number and phrase name.

• Note that you cannot perform arpeggio editing while 
a phrase is selected as the target.

4. Press the dt (w) button.
This will enter the phrase selection mode, which will 
cause  to move to the left of the phrase name.

5. Select the phrase number you want.

6. Press the dt (w) button twice.
This will move % to the original note (“ORG NOTE”).

7. Use the eo minus (–) and plus (+) buttons to 
specify the original note keyboard key name.
• You can specify a keyboard key name within the 

range of C- to G9.
• If you want the phrase always to play back as if the 

keyboard key specified by its “ORG NOTE” setting, 
regardless of the keyboard key pressed to play it, 
scroll the selection past G9 and select “Fix”.

8. Press keyboard keys and the phrase will play.

1 eo

emelds dt ekdr epdk

bn

To play a recorded phrase as 
an arpeggio

Arpeggio number Arpeggio name

Phrase number Phrase name Original note
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1. Hold down the bn (ARPEGGIO) button until 
the arpeggio type selection screen appears 
on the display.
This will cause the button’s lamp to light.

2. Use the dk (ZONE, –/+) buttons to display the 
number of the zone you want to select.

3. After making sure that  is next to the 
arpeggio number, display the number of the 
arpeggio you want to select for the zone.
• Repeat steps 2 and 3 as many times as necessary to 

select arpeggios for each of the zone.

1. Hold down the bn (ARPEGGIO) button until 
the arpeggio type selection screen appears 
on the display.
This will cause the button’s lamp to light.

2. Use the ds (u), dt (w), ek (q), and el 
(i) buttons to select “ZONE”.

3. Use the eo minus (–) and plus (+) buttons to 
turn the arpeggio of the zone on or off.

NOTE

• Note that no arpeggio also will play if the zone has 
been muted. To unmute a zone, press the dr (EXIT) 
button to exit the arpeggio type selection screen, and 
then press the two dk (ZONE, –/+) buttons at the 
same time.

There are two arpeggio types: step type and variation 
type.
• With a step type arpeggio, you can edit its steps and 

its parameters. A step type arpeggio can contain up 
to 16 steps. You can change the following settings for 
each step.

• With a variation type arpeggio, you can edit only its 
parameters.

1. Select the arpeggio type you want to edit.

2. Press the ep (EDIT) button.

3. Use the dt (w) and ek (q) buttons to select 
“Step Edit” and then press the em (ENTER) 
button.
• The “Step Edit” option will not be displayed if you 

selected a variation type arpeggio in step 1, above.

To select a different arpeggio 
for each zone

To turn the arpeggio for a 
specific zone on or off

Zone number

Editing an Arpeggio

TYPE : Specifies which note of the arpeggio should be 
played in each step, in relation to the lowest note 
(L1) or the highest note (U1) of the arpeggio. There 
is also a TYPE (P2-P5) that can be used to sound 
up to five notes at the same time.

NOTE : When you want to shift the note from the 
keyboard key that is pressed, use this setting 
specify the shift value in semitone steps.

VELO : Specifies the volume level.
CTRL : This is MIDI control data.
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4. Change the TYPE, NOTE, VELO, and CTRL settings as desired.

• While [TYPE] is selected, use the eo minus (–) and plus (+) buttons to cycle the TYPE setting between off (Off), on (TYPE) 
and tie* (TIE). Note, however, that “STEP 01” does not have a TIE option.
* Selecting TIE extends the duration of the previous step by one step. It can be used to extend the duration of notes.

• NOTE and VELO settings cannot be configured for a step whose TYPE setting is Off or TIE.
• The table below shows the settings on the arpeggio step editing menu.

5. After the TYPE, NOTE, VELO, and CTRL values are the way you want, press the dr (EXIT) button to 
return to the “ARPEGGIO” menu.

Menu Level
Description Setting

1 2

Step Edit >Ent

TYPE

Specifies what note of the arpeggio should be 
played in the currently selected step, in relation to 
the lowest note (L1) of the keyboard keys pressed.
• If the value specified for a step is greater than the 

number of keyboard keys pressed, the 
corresponding notes of the arpeggio will be 
played one octave higher. For example, if L4 is 
specified here, pressing only three keyboard 
keys will play L1, one octave higher.

• After one octave, the corresponding note will 
return back to the original octave.

L1 to L8

Specifies what note of the arpeggio should be 
played in the currently selected step, in relation to 
the highest note (U1) of the keyboard keys pressed.
• If the value specified for a step is greater than the 

number of keyboard keys pressed, the 
corresponding notes of the arpeggio will be 
played one octave lower. For example, if U4 is 
specified here, pressing only three keyboard 
keys will play U1, one octave lower.

• After one octave, the corresponding note will 
return back to the original octave.

U1 to U8

Specifies what note should be played in the 
currently selected step, in relation to the highest 
note of the keyboard keys pressed.
• If the number of keys pressed is less than the 

value specified here, the arpeggio is played only 
up to the keys pressed.

P2 to P5

NOTE
Specifies a shift of the note sounded, in semitone 
steps, from the notes of the keys played on 
keyboard.

–24 - 0 - +24

VELO
Changes the velocity (volume level) of the 
keyboard keys that are pressed.

–64 - 0 - +63

CTRL
This setting can be used to change the control type 
value selected with the arpeggio parameter editing 
menu in step 7 of this procedure, below.

Bend: –128 to 0 to +127,
Pan (Control Change 10): 
–64 to 0 to +63, 
Control Change 00 to 97 
(except for Pan): 
0 to 127

Step type Step number
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6. Use the dt (w) and ek (q) buttons to move the selection cursor (0) to “Parameter” and then press 
the em (ENTER) button.

7. Change parameters as desired.
• The table below shows the contents of the arpeggio parameter editing menu.

• For information about parameters that need to be edited to playback an arpeggio with a stage setup, see “Using the Stage 
Setups (Tutorial)” (page E-31).

Menu Level
Description Setting

1 2

Parameter >Ent

Max Step
Maximum step. This parameter can be changed for 
step type only.

1 - 16

Step Size Step size. Specifies the note length between steps. 2, 6, , 7, , 8

Note Length

Note length. Note on note length specified as a 
percentage of the step size. 100% specifies the same 
size as the original, while 50% specifies a note 
length that is half the original.

1 - 100%

Groove
Groove. Specifies the on note timing of the off-beat 
step. 50% specifies even, while a larger value 
increases the first half note length.

10 - 90%

Groove Type
Groove type. Specifies the note length type when 
anything other than 50% is specified for Groove.

Normal: Playback performed with 
step length based on actual 
percentage.
Short: When step length is changed, 
adjusts the step to the shorter length.

Velocity
Velocity. Specifies the velocity value of an input 
arpeggio. Specifying “KeyOn” inputs a velocity 
value in accordance with applied key pressure.

KeyOn, 1 to 127

Hold Pedal
Hold pedal. Enables/disables hold using a pedal. 
This parameter can be changed for step type only.

Off, On

Control 
Track

Control track. Enables (On) or disables (Off) use of 
control data. Selecting “Only” causes only the 
control track to be valid. This parameter can be 
changed for step type only.

Off, On, Only

Control 
Type

Control type. Specifies the control data type. This 
parameter can be changed for step type only.

Bend, C. (Control Change) 00 - 97

Smooth
Smooth. Selecting “On” causes control data to be 
supplemented. This parameter can be changed for 
step type only.

Off, On
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Use the procedure below to clear preset step data or 
step data that was edited using Step Edit (page E-25) 
and create new step data from scratch.
• Note that the variation type cannot be cleared.

1. While the arpeggio type selection screen is 
displayed, press the ep (EDIT) button.

2. Use the dt (w) and ek (q) buttons to select 
“Clear Step” and then press the em (ENTER) 
button.

This should cause “Clear?” to appear on the display.

3. Press the em (ENTER) button again.
This will display a confirmation message (“SURE?”).

4. Press the eo (YES) button.
The message “Complete!” will appear on the display 
when the data is deleted.

After editing an arpeggio, you can give it a name and 
save it as a user arpeggio.

1. Perform steps 1 through 2 of the procedure 
under “Editing an Arpeggio”, (page E-25).

2. Use the ds (u), dt (w), ek (q), and el 
(i) buttons to select “NameEdit”, and then 
press the em (ENTER) button.

3. Edit the name as desired.

Clearing Arpeggio Step Data

Renaming an Arpeggio
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• The total memory capacity for recording with the 
phrase sequencer is approximately 1MB. The 
maximum allowable size of a single phrase is 
approximately 8KB.

• In addition to what you play on the keyboard, your 
pedal, wheel, knob, and slider operations are also 
recorded as part of phrase. However, operations can 
be recorded when the MIDI channel messages below 
are assigned to pedals, modulation wheel, knobs, 
and sliders.
– CC00 to CC97
– NRPN
– RPN
– Pressure

In addition to the track editing operations described in 
the USER’S GUIDE (Basics), the song (song sequencer) 
screen can also be used to edit the settings below.
– Mixer settings when playing back a song
– Changing the tempo when playing back a song
– Clearing a track
– Initializing a song

1. Select the song you want.

1

dk em

eo

dr

Recording with the Phrase 
Sequencer

Mixer Settings When Playing 
Back a Song
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2. Edit the song as desired.
• To configure mixer settings, select “Song Mixer”.

• The parameters of the mixer settings are described in the table below.

Display Text Description Setting

Bank Select MSB

Bank select MSB. Specifies the bank select MSB number.
• To specify a tone on the song mixer screen, specify “Bank Select MSB” and 

“Program Change” numbers, referring to the “Tone List” at the back of this 
manual.

0 - 127

Program Change
Program change. Specifies the program change number. For details, see “Bank 
Select MSB”, above.

0 - 127

Channel Specifies the output channel number. 1 - 16

Volume Volume. 0 - 127

Pan Panning. Adjusts the left-right position of sound in the stereo field. –64 - 0 - +63

Coarse Tune Coarse tune. Shifts the pitch of notes by semitone units. –24 - 0 - +24

Fine Tune Fine tune. Shifts the pitch of notes by cent units. –99 - 0 - +99

Bend Range
Bend range. Specifies (in semitone units) the maximum change in pitch when the 
1 (BENDER) wheel is rotated.

0 - 24

Chorus Send Chorus send. Specifies how the chorus effect is applied. 0 - 127

Delay Send Delay send. Specifies how the delay effect is applied. 0 - 127

Reverb Send Reverb send. Specifies how the reverb effect is applied. 0 - 127

Generator Out
Internal send (Gen Out) on/off. Specifies whether or not to send information 
about each part to the Digital Piano’s internal sound source.

Off, On

USB Out
USB output (USB Out) on/off. Specifies whether or not MIDI send of the 
information of each part is performed from et (USB).

Off, On

MIDI Out
MIDI output (MIDI Out) on/off. Specifies whether or not MIDI send of the 
information of each part is performed from fl (MIDI OUT/THRU).

Off, On

1. Perform steps 1 and 2 of the procedure under 
“Mixer Settings When Playing Back a Song” 
(page E-29) to select “Tempo”.

2. Adjust the tempo setting.

1. Perform steps 1 and 2 of the procedure under 
“Mixer Settings When Playing Back a Song” 
(page E-29) to select the setting you want.
• To clear a track, select “Track Clear”. Next, on the 

screen that appears, use the dk minus (–) and plus (+) 
buttons to select the track you want to clear.

• To initialize the song, select “Song Initialize”.

2. Press the em (ENTER) button.
• This will display a confirmation message (“SURE?”).
• If you want to cancel the operation, press the eo (NO) 

or dr (EXIT) button.

3. Press the eo (YES) button.
• “Complete!” appears on the display after the process 

is complete.

To change the tempo when 
playing back a song

To clear a track or initialize a 
song
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1. Select the bank and stage setup number you want.

2. Edit the stage setups as desired.
• The following describes each of the editable parameters.

Editable Parameters

To edit a stage setup

Display Text Description Settings

Zone Edit >Ent
Zone parameter edit. This group includes parameters for Zone 1 through 4.
• Use the dk (ZONE) minus (–) and plus (+) buttons to select the zone you 

want to edit.

Mixer Edit >Ent Mixer edit. This group includes parameters for the mixer within zones.

Zone Enable Zone on/off. Turns all zones on or off. This setting is different from the 
mixer function part on/off (Part Enable) (page E-37) setting. Off, On

Tone

Tone. Selects the tone for each zone. This setting is the same as the mixer 
function part tone (page E-37). Use buttons bo through cl to switch between 
tone categories.
• While this item is selected, you can select a tone using the same operation 

as that used in the Tone Mode.
• The DRM (drums) category cannot be selected for Zone 2. DRM (drums) 

and HEX (hex layer) cannot be selected for to Zone 3 or Zone 4. Pressing 
the button of a category that cannot be selected causes the message 
“Invalid Tone” to be displayed. If this happens, wait until the message 
disappears or press another category button to clear it.

PNO (Piano): 
P00 to U39
EPN (Electric Piano): 
P000 to U109
ORG (Organ): 
P00 to U49
STR (Strings, Brass): 
P00 to U89
GTR (Guitar, Bass): 
P00 to U59
VAR (Synthesizer, 
Various): P000 to U129
DRM (Drums): 
P00 to U39
HEX (Hex Layer): 
P000 to U199

Key Range Low

Key Range Low. Specifies the low key range of the keyboard for each zone. 
This setting is used in combination with the Key Range High setting to 
configure key ranges for each zone.
For example, configuring F3 (low) to C7 (high) for Zones 1 and 2, and C2 
(low) to E3 (high) for Zones 3 and 4 will enable play of Zone 1 and 2 tones on 
the right side keyboard range, and the Zone 3 and 4 tones on the left side 
keyboard in the illustration below.

• After pressing the en (NUM KEY) button to enter the number input 
mode, you can use the keyboard keys to enter values.

C- - G9

1

dk

cl

em

2 3

4 5 6 7 8 9

bo bp bq br bs bt ck

ct

en

C2 F3E3 C7

Zone 3
Zone 4

Zone 1
Zone 2
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Key Range High

Key Range High. Specifies the high range of the keyboard for each zone. 
This setting is used in combination with the Key Range Low setting to 
configure key ranges for each zone.
• After pressing the en (NUM KEY) button to enter the number input 

mode, you can use the keyboard keys to enter values.

C- - G9

Velo.Range Low
Velocity range low. This is the minimum velocity value of each zone. This 
setting is used in combination with the Velo.Range High setting below to 
configure velocity ranges for each zone.

0 - 127

Velo.Range 
High

Velocity range high. This is the maximum velocity value of each zone. This 
setting is used in combination with the Velo.Range Low setting above to 
configure velocity ranges for each zone.

0 - 127

Volume
Volume. This setting is the same as the mixer function part volume (page 
E-37).

0 - 127

Pan
Panning. Adjusts the left-right position of sound in the stereo field. This 
setting is the same as the mixer function part panning (page E-37).

–64 - 0 - +63

Coarse Tune Coarse tune. Shifts the pitch of notes by semitone units. –24 - 0 - +24

Fine Tune
Fine tune. This setting is the same as the mixer function part fine tune (page 
E-37).

–99 - 0 - +99

Bend Range 
Down

Bend range down. Pitch change amount for downward bender operation. 0 - 24

Bend Range Up Bend range up. Pitch change amount for upward bender operation. 0 - 24

Chorus Send Chorus send. This setting is the same as the mixer chorus send (page E-37). 0 - 127

Delay Send Delay send. This setting is the same as the mixer delay send (page E-37). 0 - 127

Reverb Send Reverb send. This setting is the same as the mixer reverb send (page E-37). 0 - 127

Resonance Send
Resonance send. Enables/disables send to the resonance function of each 
zone.

Off, On

Reso.Return 
Level

Resonance return level. This setting is the same as the mixer resonance 
return (page E-37).

0 - 127

Controller Edit >Ent Controller parameters. This is a group of editable controller parameters.

Knob1 Enable
Knob 1 on/off (Knob 1 enable). Enables/disables 3 (K1) operation for each 
zone.

Off, On

Knob2 Enable
Knob 2 on/off (Knob 2 enable). Enables/disables 3 (K2) operation for each 
zone.

Off, On

Knob3 Enable
Knob 3 on/off (Knob 3 enable). Enables/disables 3 (K3) operation for each 
zone.

Off, On

Knob4 Enable
Knob 4 on/off (Knob 4 enable). Enables/disables 3 (K4) operation for each 
zone.

Off, On

Slider1 Enable
Slider 1 on/off (Slider 1 Enable). Enables/disables 4 (S1) operation for each 
zone.

Off, On

Slider2 Enable
Slider 2 on/off (Slider 2 Enable). Enables/disables 5 (S2) operation for each 
zone.

Off, On

Slider3 Enable
Slider 3 on/off (Slider 3 Enable). Enables/disables 6 (S3) operation for each 
zone.

Off, On

Slider4 Enable
Slider 4 on/off (Slider 4 Enable). Enables/disables 7 (S4) operation for each 
zone.

Off, On

Slider5 Enable
Slider 5 on/off (Slider 5 Enable). Enables/disables 8 (S5) operation for each 
zone.

Off, On

Slider6 Enable
Slider 6 on/off (Slider 6 Enable). Enables/disables 9 (S6) operation for each 
zone.

Off, On

Bender Enable
Bender on/off (bender enable). Enables/disables 1 (BENDER) operation 
for each zone.

Off, On

Wheel Enable
Modulation wheel on/off (wheel enable). Enables/disables 2 
(MODULATION) operation for each zone.

Off, On

Pedal1 Enable
Pedal 1 on/off (pedal 1 enable). Enables/disables operation of a pedal 
connected to fk (DAMPER/PEDAL 1) for each Zone.

Off, On

Display Text Description Settings
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Pedal2 Enable
Pedal 2 on/off (pedal 2 enable). Enables/disables of fk (PEDAL 2) for each 
zone.

Off, On

Arpeggio 
Enable

Arpeggio on/off (arpeggio enable). Enables/disables arpeggio function 
(page E-24) for each zone.

Off, On

Arpeggio Select 
>Ent

Arpeggio select. This is a group of editable arpeggio function parameters.

Target
Target. Selects playback of an arpeggio (Arp) or phrase sequencer (Phr) by 
the arpeggio function. For details, see “To play a recorded phrase as an 
arpeggio” (page E-24).

Arp, Phr

Arpeggio 
Number

Arpeggio number. Use this setting to select an arpeggio number (page E-24). P000 - U199

Arp.Phrase 
Numb

Arpeggio phrase number. Select the number of the phrase to be played back 
when the arpeggio target (Target) is “Phrase”. For details, see “To play a 
recorded phrase as an arpeggio” (page E-24).

U000 - U999

Original Key
Original key. Specifies playback in the original key used for recording when 
performing key play. For details, see “To play a recorded phrase as an 
arpeggio” (page E-24).

C- - G9, Fix

MIDI Edit >Ent
MIDI parameter. This is a group of MIDI-related (page E-39) editable 
parameters. Use the dk (ZONE) minus (–), plus (+) buttons to select one of 
the Digital Piano’s 16 sound source parts for editing.

Octave Shift Octave shift. Shifts the tone of notes by octave units. –2 - 0 - +2

Transpose
Transpose. Shifts the pitch of notes by semitone units. This setting is the 
same as the mixer function part coarse tune (page E-37).

–12 - 0 - +12

External Out Ch
External send channel (external out channel). Specifies the MIDI channel 
(page E-39) for sending information about each part by MIDI to an external 
destination.

1 - 16

Generator Out
Internal send (Generator Out) on/off. Specifies whether or not to send 
information about each part to the Digital Piano’s internal sound source.

Off, On

MIDI Out
MIDI output (MIDI Out) on/off. Specifies whether or not MIDI send of the 
information of each part is performed from fl (MIDI OUT/THRU).

Off, On

USB Out
USB output (USB Out) on/off. Specifies whether or not MIDI send of the 
information of each part is performed from et (USB).

Off, On

Prog & Bank 
Out

Program change and bank MSB send on/off. Enables/disables MIDI 
external send of information about each part from program change (Prg) or 
bank MSB (Bnk).

Off, Prg, Bnk

PrgBank Edit 
>Ent

This is a group of program change and bank MSB editable parameters 
(program change/bank MSB edit). Editing can be performed even when the 
“ProgBank Out” setting is “Off”.

Bank MSB Bank MSB. Inputs a program change bank MSB value. 0 - 127

Bank LSB Bank LSB. Inputs a program change bank LSB value. 0 - 127

Prog.Change Program change. Inputs a program change value. 1 - 128

System Effect Edit >Ent

System effect parameter. This is a group of editable system effect parameters 
(page E-18).
For details about group items, see “Editable SYSTEM Parameters” 
(page E-23).

Chorus Edit >Ent
Chorus edit. This is a group of editable chorus parameters within the system 
effects.

Delay Edit >Ent
Delay edit. This is a group of editable delay parameters within the system 
effects.

Reverb Edit >Ent
Reverb edit. This is a group of editable reverb parameters within the system 
effects.

String Reso Send String resonance send. Adjusts the send level to string resonance. 0 - 15

Damper Reso Send Damper resonance send. Adjusts the send level to damper resonance. 0 - 15

Damper Noise 
Enable

Damper noise enable. Enables/disables the damper noise effect. Off, On

Display Text Description Settings
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Master Effect Edit >Ent
Master effect parameter. This is a group of editable master effect parameters 
(page E-23). For details about group items, see “Editable MASTER 
Parameters” (page E-23).

Compressor Edit 
>Ent

Compressor edit. This is a group of editable compressor parameters within 
master effects.

Equalizer Edit >Ent
Equalizer edit. This is a group of editable equalizer parameters within 
master effects.

Common Edit >Ent This is a group of editable pedal, PRN, and NPRN parameters.

Tempo
Tempo. Adjusts the phrase playback speed. You also can change the phrase 
playback tempo using the ct (TEMPO) button.

20 - 255

Phrase Phrase number. Selects the phrase of the Phrase Sequencer (page E-29). U000 - U999

Arpeggio
Preset arpeggio type selection. See “To use the Arpeggio Function” in the 
separate USER’S GUIDE (Basics).

Off, On, Hold

Hammer Response
Hammer response. Adjusts hammer response within the range of 0 (fast) to 
7 (slow).

0 - 7

Knob1 Edit >Ent
Knob 1 (Knob 1 edit). This is a group of 3 (K1) knob editable parameters. 
Editing can be performed even when the “Knob 1 Enable” setting is “Off”.

Target

Target. Selects the parameters to be controlled by a controller. For example, 
the “CC67:Soft” setting specifies a soft pedal effect.
• Two targets can be specified for a single controller. Use the dk (ZONE) 

minus (–), plus (+) buttons to switch between Target 1 and Target 2.
No Assign: No target specified.
CC00 to CC97: MIDI control change*1

NRPN, RPN: MIDI NRPN and RPN parameters*1 *2

Ch.Pressure: MIDI channel pressure*1

Tempo: Tempo setting (page E-30)
EQ Low Gain - EQ High Gain: Master EQ >Low Gain - High Gain (page 
E-23)
DSP Bypass: Temporarily bypasses the DSP of the currently selected zone.
Ext.Volume: Control the External Volume value.
Layer Detune: Layer detune (page E-17)
Layer1 Volume - Layer6: Tone parameter settings of each layer
• The following can be assigned: Volume (Volume), Pan (panning), OctShift 

(octave shift), DspOnOff (DSP on/off), LfoPitch (LFO pitch), LfoFiltr (LFO 
filter), LfoAmp (LFO amp). For details about each setting, see the editable 
parameters under “Using Built-in Tones (Tutorial)” on page E-10.

Dsp Param 1-16: DSP parameters
Pedal1 On Rate, Pedal1 Off Rate, Pedal2 On Rate, Pedal2 Off Rate: on value, 
on rate, off value, off rate for each pedal*3

Arp Hold On/Off: Arpeggio hold setting*4

Song Str/Stp: Song sequencer playback start/stop*4

Phrase Str/Stop: Phrase playback start/stop*4

Audio Str/Stop: Audio playback start/stop*4

Refer to the cell to the 
left.

Min Value Minimum value. Controller minimum output value setting. 0 - 127

Max Value Maximum value. Controller maximum output value setting. 0 - 127

Knob2-4 Edit >Ent

Knob 2 to 4 (Knob 2 to 4 edit). This is a group of 3 Knob (K2) through (K4) 
editable parameters. Editing can be performed even when the “Knob 2-4 
Enable” setting is “Off”. Details of editable parameters are the same as 
“Knob1 Edit >Ent”, above.

Display Text Description Settings

*1 For details about each setting, see the MIDI Implementation Chart 
(http://world.casio.com/) and/or MIDI documentation.

*2 After selecting these setting items, press the em (ENTER) button again 
and then adjust the items below.
MSB: 63H for NRPN, 65H for RPN (Setting range: 000 to 127)
LSB: 62H for NRPN, 64H for RPN (Setting range: 000 to 127)
Send Data: Specifies whether knob operation controls MSB or LSB 
value. (Settings: MSB, LSB)

*3 This setting is not supported for Damper/Pedal 1 (Pedal 1) or Pedal 2.
*4 This setting is supported for Damper/Pedal 1 (Pedal 1) and Pedal 2 only.
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Slider1-6 Edit >Ent

Slider 1 to 6 edit. This is a group of 4 Slider (S1) through 9 Slider (S6) 
editable parameters. Editing can be performed even when the “Slider 1-6 
Enable” setting is “Off”. Details of editable parameters are the same as 
“Knob1 Edit >Ent”, above.

Modulation Edit 
>Ent

Modulation wheel (modulation wheel edit). This is a group of 2 
(MODULATION) wheel editable parameters. Editing can be performed 
even when the “Wheel Enable” setting is “Off”. Details of editable 
parameters are the same as “Knob1 Edit >Ent”, above.

Pedal1 Edit >Ent
Damper/Pedal 1 (Pedal1). This is a group of editable parameters for the 
pedal connected to fk (DAMPER/PEDAL 1). Editing can be performed even 
when the “Pedal1 Enable” setting is “Off”.

Pedal Target 
Edit >Ent

Specifies the function of the pedal connected to fk (DAMPER/PEDAL 1). 
Details of editable parameters are the same as “Target”, above.

On Rate On rate. On value change rate. 0 - 127

Off Rate Off rate. Off value change rate. 0 - 127

Pedal2 Edit >Ent

Pedal2. This is a group of editable parameters for the pedal connected to fk 
(PEDAL 2). Editing can be performed even when the “Pedal2 Enable” 
setting is “Off”. Details of editable parameters are the same as “Pedal1 Edit 
>Ent”, above.

Display Text Description Settings
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In addition to the system setting screen described in the 
USER’S GUIDE (Basics), the settings listed below, 
which also affect Digital Piano global settings, can also 
be configured.
• Mixer function
• Temperament
• Touch sensitivity adjustment
• Stage setup filter
• MIDI functions
• Digital Piano information (Check of system version 

in built-in memory, firmware update)

The mixer lets you make adjustments to the tone, 
volume level, and other settings* of the Digital Piano’s 
sound source parts (Parts 01 through 16, external input 
parts, page E-5), while viewing the balance between the 
parts on the display.
* Settings that affect individual parts are called “part 

settings”, while settings that affect all parts are 
called “master settings”.

1. Press the bm (SYS SETTING) button.

2. Use the ds (u), dt (w), ek (q), and el 
(i) buttons to select “Sound Generator”.

3. Press the em (ENTER) button.

4. Change the setting.
• For information about setting items, see “Setting 

Items” (page E-37).

5. After settings are the way you want, press the 

bm (SYS SETTING) button to exit the setting 
screen.

1

dk

cl

em

bo bp bq br bs bt ck

elds dt ek

eobm

System Settings

Using the Mixer
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Setting Items

Display Text Description Settings

Tuning Tuning. Fine tuning of global pitch in 0.1 Hertz steps. 415.5 - 465.9Hz

Master Volume Master volume. Adjusts the volume of all the parts. 0 - 127

Master Pan
Master panning (master panning). Adjusts the left-right position of sound in the 
stereo field of all the parts.

–64 - 0 - +63

External Volume External input volume setting. 0 - 127

Mixer Part1-16 >Ent
Mixer Part 1 through Mixer Part 16. These are setting items for Mixer Part 1 
through Mixer Part 16. You can also use dk (PART) minus (–) and plus (+) 
buttons to select a part.

Part Enable Part on/off (Part Enable). Turns each part on or off. Off, On

Tone

Part tone. This is the tone of each part. Use buttons bo through cl to switch 
between tone categories.
• While this item is selected, you can select a tone using the same operation as 

that used in the Tone Mode.
• The DRM (drums) category cannot be selected for Zone 2. DRM (drums) and 

HEX (hex layer) cannot be selected for to Zone 3 or Zone 4. Pressing the 
button of a category that cannot be selected causes the message “Invalid 
Tone” to be displayed. If this happens, wait until the message disappears or 
press another category button to clear it.

PNO (Piano): 
P00 to U39
EPN (Electric Piano): 
P000 to U109
ORG (Organ): 
P00 to U49
STR (Strings, Brass): 
P00 to U89
GTR (Guitar, Bass): 
P00 to U59
VAR (Synthesizer, 
Various): P000 to U129
DRM (Drums): 
P00 to U39
HEX (Hex Layer): 
P000 to U199

Volume Part volume. This is the volume of each part. 0 - 127

Pan Part panning. Adjusts the left-right position of sound in the stereo field. –64 - 0 - +63

Coarse Tune Part coarse tune. Shifts the pitch of notes by semitone units. –24 - 0 - +24

Fine Tune Part fine tune. Shifts the pitch of notes by cent units. –99 - 0 - +99

Bend Range
Part bend range. Specifies (in semitone units) the maximum change in pitch 
when the 1 (BENDER) wheel is rotated.

0 - 24

Chorus Send
Part chorus send. Controls how the chorus effect (page E-18) is applied to each 
part.

0 - 127

Delay Send
Part delay send. Controls how the delay effect (page E-18) is applied to each 
part.

0 - 127

Reverb Send
Part reverb send. Controls how the reverb effect (page E-18) is applied to each 
part.

0 - 127

Resonance Send
Resonance send. Enables/disables send to the resonance function of each mixer 
part (page E-18). However, note that this setting cannot be changed for Mixer 
Part 5 and higher.

Off, On

Reso.Return 
Level

Resonance return level. Adjusts the return level of the resonance function for 
each mixer part. Only certain tones can be edited. Note that this setting cannot 
be changed for Mixer Part 5 and higher.

0 - 127

Temperament >Ent
Temperament. This item specifies the temperament of the internal sound 
source.

Type

Type. One of the 17 temperaments below can be selected.

00 - 16

Root Root note (root). Specifies the root note of the temperament. C - B

00 : Equal
01 : Pure Major
02 : Pure Minor
03 : Pythagorean
04 : Kirnberger 3
05 : Werckmeister
06 : Mean-Tone
07 : Rast
08 : Bayati

09 : Hijaz
10 : Saba
11 : Dashti
12 : Chahargah
13 : Segah
14 : Gurjari Todi
15 : Chandrakauns
16 : Charukeshi

Download from Www.Somanuals.com. All Manuals Search And Download.



E-38

Other Useful Functions (Tutorial)

This item is for adjusting how much the sound volume 
and timbre changes, and how it changes in accordance 
with keyboard pressure.

1. Press the bm (SYS SETTING) button.

2. Use the ds (u), dt (w), ek (q), and el 
(i) buttons to select “General”.

3. Press the em (ENTER) button.

4. Use the ds (u), dt (w), ek (q), and el 
(i) buttons to select a setting item.

Setting Item

5. Change the setting.

6. After settings are the way you want, press the 

bm (SYS SETTING) button to exit the setting 
screen.

Recalling a stage setup causes Digital Piano parameters 
to be overwritten with the content of the setup. If you 
create a stage setup filter, the parameters assigned to 
the filter are not overwritten to be recall of a stage 
setup, so they retain their current settings.

1. Press the bm (SYS SETTING) button.

2. Use the ds (u), dt (w), ek (q), and el 
(i) buttons to select “General”.

3. Press the em (ENTER) button.

4. Use the ds (u), dt (w), ek (q), and el 
(i) buttons to select “Stage Set Filter”.

5. Press the em (ENTER) button.

6. Use the dt (w) button to select a setting 
item, and then press the em (ENTER) button.
• Use the eo minus (–) and plus (+) buttons to select 

either “Off” (to allow overwriting of the setting item) 
or “On” (to disable overwriting of the setting item).

Setting Item

Adjusting the Touch 
Sensitivity

Display Text Description Settings

Touch

Touch. Specifies touch 
sensitivity when the keyboard is 
played.
Off: Notes sound at a fixed 
volume level regardless of 
keyboard pressure.
Light: High-volume notes are 
easily produced even with light 
keyboard pressure.
Normal
Heavy: Normal sound is 
produced when relatively heavy 
pressure is applied.

Refer to 
the cell to 
the left.

Touch Off 
Velo

Touch off velocity. Specifies the 
volume level at which the above 
touch setting values become off.

1 - 127

Stage Setup Filter

Display Text Description Settings

Tempo
Tempo. When “On” is selected, 
recall of tempo parameters 
(page E-34) is disabled.

Off, On

Arpeggio

Arpeggio. When “On” is 
selected, recall of arpeggio 
parameters (page E-34) is 
disabled.

Off, On

Phrase
Phrase. When “On” is selected, 
recall of phrase parameters 
(page E-34) is disabled.

Off, On

Hammer 
Response

Hammer response. When “On” 
is selected, recall of hammer 
response parameters (page E-34) 
is disabled.

Off, On

Chorus

System chorus. When “On” is 
selected, recall of system chorus 
parameters (page E-23) is 
disabled.

Off, On

Delay

System delay. When “On” is 
selected, recall of system delay 
parameters (page E-23) is 
disabled.

Off, On
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7. After settings are the way you want, press the 

bm (SYS SETTING) button to exit the setting 
screen.

What is MIDI?

MIDI is a standard for digital signals and connectors 
that allows musical instruments, computers, and other 
devices, regardless of manufacturer, to exchange data 
with each other.
For details about the MIDI specifications of this Digital 
Piano, see the “MIDI Implementation” document at the 
website located at the URL below.
http://world.casio.com/

NOTE

• Use a separately available or commercially available 
MIDI cable to connect the MIDI terminals of your 
Digital Piano and another electronic musical 
instrument for exchange of MIDI data.

• For information about the relationship between each 
Digital Keyboard part (page E-36) and the MIDI IN 
and MIDI OUT channels, see “To edit a stage setup” 
(page E-31).

• This Digital Piano conforms to General MIDI Level 1 
(GM).

MIDI Settings

1. Press the bm (SYS SETTING) button.

2. Select “MIDI>Ent” and then press the em 
(ENTER) button.

3. Change the setting.

Reverb

System reverb. When “On” is 
selected, recall of system reverb 
parameters (page E-23) is 
disabled.

Off, On

Compressor

Master compressor. When “On” 
is selected, recall of master 
compressor parameters (page 
E-23) is disabled.

Off, On

Equalizer

Master equalizer. When “On” is 
selected, recall of master 
equalizer parameters (page 
E-23) is disabled.

Off, On

Pedal1

Pedal1. When “On” is selected, 
recall of Pedal 1 parameters 
(page E-32) is disabled.
• For Stage Inc and Stage Dec, 

this operation is always 
executed, regardless of the 
stage setting.

Off, On, 
Stage Inc, 
Stage Dec

Pedal2
Pedal2. Settings are the same as 
Pedal 1, above.

Display Text Description Settings Using MIDI
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Setting Item

Display Text Description Settings

Transpose Transpose. Shifts the pitch of notes by semitone units. –12 - 0 - +12

Octave Shift Octave shift. Shifts the tone of notes by octave units. –3 - 0 - +3

Local Control

Local control. Turning off local control disables the Digital Piano’s internal 
sound source, so nothing sound when keyboard keys are pressed. Turn off 
local control when you want to use the Digital Piano keyboard and pedal 
operations to operate an external sound source, without producing any sound 
from the Digital Piano itself.

Off, On

High Reso Out High-resolution velocity MIDI out on/off. Off, On

Device ID

Device ID. Selects the ID number of the Digital Piano for MIDI system 
exclusive message send/receive.
• While “All” is selected, a system exclusive message is sent regardless of the 

ID number.
• For details about the ID number, see MIDI Implementation at 

http://world.casio.com/.

1 - 16, ALL

Basic Ch
Basic channel. Specifies the receive channel of “Stage Set Change”, and other 
MIDI messages described below.

1 - 16

MIDI Out Select

MIDI OUT select. Specifies what is output as MIDI OUT.
KEY (Keyboard): Digital Piano keyboard play, operations, etc.
MIDI (MIDI IN): Messages input via fl (MIDI IN) (MIDI THRU)
USB (USB IN): Messages input via et (USB)

Refer to the cell to the 
left.

USB Out Select
USB out select. Specifies what is output as USB out.
KEY (Keyboard): Keyboard and other Digital Piano operations.
MIDI (MIDI IN): Messages input via fl (MIDI IN)

Refer to the cell to the 
left.

MIDI In Enable
MIDI IN on/off (MIDI IN enable). While this setting is turned on, messages 
input via fl (MIDI IN) are reflected by the Digital Piano’s internal sound 
source.

Off, On

USB In Enable
USB IN on/off (USB IN enable). While this setting is turned on, messages input 
via et (USB) are reflected by the Digital Piano’s internal sound source.

Off, On

Sync Mode

Sync mode. Settings for MIDI syncing between the Digital Piano and an 
external device.
Off: No syncing.
Master: Outputs Clock, Start/Stop (Song Sequencer), and other signals from 
the Digital Piano to control an external device.
Slave: Receives Clock, Start/Stop, and other signals from an external device.
• Song sequencer playback cannot be performed if a clock is not received. 

Start/stop is regarded as song sequencer operation.

Refer to the cell to the 
left.

Stage Set.Chg

Stage setup change.
PrgBnk: Program Change Bank = 70H. Also output when this operation is 
performed.
NRPN: Select by NRPN MSB = 24H, LSB = 00H. Also output when this 
operation is performed.

PrgBnk, NRPN
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4. After settings are the way you want, press the 

bm (SYS SETTING) button to exit the setting 
screen.

NOTE

• You can also use stage setup editing to change the 
MIDI data send channel and configure other 
settings. For more information, see the “MIDI Edit 
>Ent” group (page E-33).

You can use the system setting information 
(Information) screen to check the version of the system 
loaded in Digital Piano memory, and to update the 
firmware.

1. Press the bm (SYS SETTING) button.

2. Use the ds (u), dt (w), ek (q), and el 
(i) buttons to select “Information”.

3. Press the em (ENTER) button.

4. Use the dt (w) button to select a setting 
item, and then press the em (ENTER) button.
Version: Checks the version of the system in Digital 
Piano memory.
• This is only a check, so there are no settings.

Update Firmware: Updates the firmware.
• For information about the latest firmware and how to 

update, visit the website below.
http://world.casio.com/

5. After settings are the way you want, press the 

bm (SYS SETTING) button to exit the setting 
screen.

Digital Piano Information
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Reference

Tone List

Group 
Name Number Tone Name Screen Name

Sending and Receiving Receiving Only

Program 
Change

Bank 
Select 
MSB

Program 
Change

Bank 
Select 
MSB

PIANO 000
GRAND PIANO 
CONCERT

GrPnoConcert 0 64 0 48

PIANO 001 ROCK PIANO Rock Piano 1 64 1 48

PIANO 002
GRAND PIANO 
STUDIO

GrPno Studio 2 64 0 54

PIANO 003
GRAND PIANO 
MODERN

GrPno Modern 3 64 0 49

PIANO 004 LA PIANO LA Piano 4 64 1 49

PIANO 005 DANCE PIANO Dance Piano 5 64 1 50

PIANO 006
GRAND PIANO 
BRIGHT

GrPno Bright 6 64 1 51

PIANO 007
GRAND PIANO 
MELLOW

GrPno Mellow 7 64 0 51

PIANO 008 MONO PIANO 1 Mono Piano 1 8 64 0 56

PIANO 009 MONO PIANO 2 Mono Piano 2 9 64 0 57

PIANO 010 TACK PIANO Tack Piano 10 64 0 58

PIANO 011
GRAND PIANO 
CLASSIC

GrPnoClassic 11 64 0 50

PIANO 012
GRAND PIANO 
DOLCE

GrPianoDolce 12 64 0 55

PIANO 013 HONKY-TONK Honky-Tonk 13 64 3 48

PIANO 014 OCTAVE PIANO Octave Piano 14 64 3 49

PIANO 015 STRINGS PIANO StringsPiano 15 64 0 52

PIANO 016 PIANO PAD Piano Pad 16 64 0 53

PIANO 017 GM PIANO 1 GM Piano 1 17 64 0 0

PIANO 018 GM PIANO 2 GM Piano 2 18 64 1 0

PIANO 019 GM HONKY-TONK GM HonkyTonk 19 64 3 0

PIANO
020 - 
039

User Tones 20 - 39 64

ELEC 
PIANO

000 AiR ELEC.PIANO 1 AiR E.Piano1 0 65 4 40

ELEC 
PIANO

001 AiR ELEC.PIANO 2 AiR E.Piano2 1 65 4 41

ELEC 
PIANO

002 AiR ELEC.PIANO 3 AiR E.Piano3 2 65 4 42

ELEC 
PIANO

003 AiR ELEC.PIANO 4 AiR E.Piano4 3 65 4 43

ELEC 
PIANO

004 AiR ELEC.PIANO 5 AiR E.Piano5 4 65 4 44

ELEC 
PIANO

005 AiR 60’S E.PIANO 1 AiR 60’s EP1 5 65 4 45

ELEC 
PIANO

006 AiR 60’S E.PIANO 2 AiR 60’s EP2 6 65 4 46

ELEC 
PIANO

007 AiR 60’S E.PIANO 3 AiR 60’s EP3 7 65 4 47

ELEC 
PIANO

008 AiR 60’S E.PIANO 4 AiR 60’s EP4 8 65 4 48

ELEC 
PIANO

009 ELEC.PIANO 1 Elec.Piano 1 9 65 4 49

ELEC 
PIANO

010 ELEC.PIANO 2 Elec.Piano 2 10 65 4 50

ELEC 
PIANO

011 ELEC.PIANO 3 Elec.Piano 3 11 65 4 51

ELEC 
PIANO

012 ELEC.PIANO 4 Elec.Piano 4 12 65 4 52

ELEC 
PIANO

013 ELEC.PIANO 5 Elec.Piano 5 13 65 4 53

ELEC 
PIANO

014 DIGITAL E.PIANO 1 Digital EP 1 14 65 5 48

ELEC 
PIANO

015 DIGITAL E.PIANO 2 Digital EP 2 15 65 5 49

ELEC 
PIANO

016 DIGITAL E.PIANO 3 Digital EP 3 16 65 5 50

ELEC 
PIANO

017 DIGITAL E.PIANO 4 Digital EP 4 17 65 5 51

ELEC 
PIANO

018 DIGITAL E.PIANO 5 Digital EP 5 18 65 5 52

ELEC 
PIANO

019 DIGITAL E.PIANO 6 Digital EP 6 19 65 5 53

ELEC 
PIANO

020 DIGITAL E.PIANO 7 Digital EP 7 20 65 5 54

ELEC 
PIANO

021 DIGITAL E.PIANO 8 Digital EP 8 21 65 5 55

ELEC 
PIANO

022 DIGITAL E.PIANO 9 Digital EP 9 22 65 5 56

ELEC 
PIANO

023 DYNO ELEC.PIANO 1 DynoE.Piano1 23 65 4 54

ELEC 
PIANO

024 DYNO ELEC.PIANO 2 DynoE.Piano2 24 65 4 55

ELEC 
PIANO

025 60’S ELEC.PIANO 1 60’sE.Piano1 25 65 4 56

ELEC 
PIANO

026 60’S ELEC.PIANO 2 60’sE.Piano2 26 65 4 57

ELEC 
PIANO

027 PHASER E.PIANO 1 Phaser EP 1 27 65 4 58

ELEC 
PIANO

028 PHASER E.PIANO 2 Phaser EP 2 28 65 4 59

ELEC 
PIANO

029 AMP E.PIANO 1 Amp E.Piano1 29 65 4 60

ELEC 
PIANO

030 AMP E.PIANO 2 Amp E.Piano2 30 65 4 61

ELEC 
PIANO

031 CRUNCH E.PIANO Crunch EP 31 65 4 62

ELEC 
PIANO

032 DIZZY E.PIANO Dizzy EP 32 65 4 63

ELEC 
PIANO

033 ANALOG E.PIANO 1 Analog EP 1 33 65 5 57

ELEC 
PIANO

034 ANALOG E.PIANO 2 Analog EP 2 34 65 5 58

ELEC 
PIANO

035 OFF VELO.CLAVI 1 OffVelClavi1 35 65 7 48

ELEC 
PIANO

036 OFF VELO.CLAVI 2 OffVelClavi2 36 65 7 49

ELEC 
PIANO

037 CLAVI 1 Clavi 1 37 65 7 50

ELEC 
PIANO

038 CLAVI 2 Clavi 2 38 65 7 51

ELEC 
PIANO

039 CLAVI 3 Clavi 3 39 65 7 52

ELEC 
PIANO

040 CLAVI 4 Clavi 4 40 65 7 53

ELEC 
PIANO

041 WAH CLAVI 1 Wah Clavi 1 41 65 7 54

ELEC 
PIANO

042 WAH CLAVI 2 Wah Clavi 2 42 65 7 55

ELEC 
PIANO

043 CRUNCH CLAVI Crunch Clavi 43 65 7 56

ELEC 
PIANO

044
OFF 
VELO.HARPSICHORD

OffVelHarpsi 44 65 6 48

ELEC 
PIANO

045 HARPSICHORD Harpsichord 45 65 6 49

ELEC 
PIANO

046
COUPLED 
HARPSICHORD

Coupl.Harpsi 46 65 6 50

ELEC 
PIANO

047 VIBRAPHONE Vibraphone 47 65 11 48

ELEC 
PIANO

048 GM E.PIANO 1 GM E.Piano 1 48 65 4 0

ELEC 
PIANO

049 GM E.PIANO 2 GM E.Piano 2 49 65 5 0

ELEC 
PIANO

050
GM ELEC.GRAND 
PIANO

GM E.G.Piano 50 65 2 0

ELEC 
PIANO

051 GM HARPSICHORD GM Harpsi. 51 65 6 0

ELEC 
PIANO

052 GM CLAVI GM Clavi 52 65 7 0

ELEC 
PIANO

053 GM CELESTA GM Celesta 53 65 8 0

ELEC 
PIANO

054 GM GLOCKENSPIEL GM Glocken. 54 65 9 0

ELEC 
PIANO

055 GM MUSIC BOX GM Music Box 55 65 10 0

ELEC 
PIANO

056 GM VIBRAPHONE GM Vibraphon 56 65 11 0

ELEC 
PIANO

057 GM MARIMBA GM Marimba 57 65 12 0

ELEC 
PIANO

058 GM XYLOPHONE GM Xylophone 58 65 13 0

ELEC 
PIANO

059 GM TUBULAR BELL GM TublarBel 59 65 14 0

ELEC 
PIANO

060 - 
109

User Tones 60 - 109 65

ORGAN 000 ROCK ORGAN 1 Rock Organ 1 0 66 16 49

ORGAN 001 ROCK ORGAN 2 Rock Organ 2 1 66 18 48

ORGAN 002 ROCK ORGAN 3 Rock Organ 3 2 66 18 49

ORGAN 003 JAZZ ORGAN 1 Jazz Organ 1 3 66 17 48

ORGAN 004 JAZZ ORGAN 2 Jazz Organ 2 4 66 17 51

ORGAN 005 PERC.ORGAN 1 Perc.Organ 1 5 66 17 49

ORGAN 006 PERC.ORGAN 2 Perc.Organ 2 6 66 17 52

ORGAN 007 PERC.ORGAN 3 Perc.Organ 3 7 66 17 53

ORGAN 008 DRAWBAR ORGAN 1 Drawbar Org1 8 66 16 48

ORGAN 009 DRAWBAR ORGAN 2 Drawbar Org2 9 66 16 50

ORGAN 010 DRAWBAR ORGAN 3 Drawbar Org3 10 66 16 51

ORGAN 011 ELEC.ORGAN 1 Elec.Organ 1 11 66 16 54

ORGAN 012 ELEC.ORGAN 2 Elec.Organ 2 12 66 16 55

ORGAN 013 ELEC.ORGAN 3 Elec.Organ 3 13 66 16 56

ORGAN 014 70’S ORGAN 70’s Organ 14 66 17 50

ORGAN 015 OVERDRIVE ORGAN 1 OverdrivOrg1 15 66 16 52

ORGAN 016 OVERDRIVE ORGAN 2 OverdrivOrg2 16 66 16 57

ORGAN 017 TREMOLO ORGAN Tremolo Org 17 66 16 53

ORGAN 018 CLICK ORGAN Click Organ 18 66 17 54

ORGAN 019 SEQUENCE ORGAN Seq.Organ 19 66 17 55

ORGAN 020 GOSPEL ORGAN Gospel Organ 20 66 17 56

ORGAN 021 CHAPEL ORGAN Chapel Organ 21 66 19 49
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ORGAN 022 GM ORGAN 1 GM Organ 1 22 66 16 0

ORGAN 023 GM ORGAN 2 GM Organ 2 23 66 17 0

ORGAN 024 GM ORGAN 3 GM Organ 3 24 66 18 0

ORGAN 025 GM PIPE ORGAN GM PipeOrgan 25 66 19 0

ORGAN 026 GM REED ORGAN GM ReedOrgan 26 66 20 0

ORGAN 027 GM ACCORDION GM Accordion 27 66 21 0

ORGAN 028 GM HARMONICA GM Harmonica 28 66 22 0

ORGAN 029 GM BANDONEON GM Bandoneon 29 66 23 0

ORGAN
030 - 
049

User Tones User 90 30 - 49 66

STRINGS/
BRASS

000 STEREO STRINGS 1 StreoString1 0 67 49 48

STRINGS/
BRASS

001 STEREO STRINGS 2 StreoString2 1 67 48 49

STRINGS/
BRASS

002 STRING ENSEMBLE String Ens. 2 67 48 48

STRINGS/
BRASS

003 SLOW STRINGS Slow Strings 3 67 49 49

STRINGS/
BRASS

004 BRIGHT STRINGS BriteStrings 4 67 48 50

STRINGS/
BRASS

005 WARM STRINGS Warm Strings 5 67 48 51

STRINGS/
BRASS

006 SYNTH-STRINGS 1 Syn-Strings1 6 67 50 48

STRINGS/
BRASS

007 SYNTH-STRINGS 2 Syn-Strings2 7 67 51 48

STRINGS/
BRASS

008 SYNTH-STRINGS 3 Syn-Strings3 8 67 51 49

STRINGS/
BRASS

009 70’S SYNTH-STR. 70’s Syn-Str 9 67 50 49

STRINGS/
BRASS

010 80’S SYNTH-STR. 80’s Syn-Str 10 67 50 50

STRINGS/
BRASS

011 VIOLIN SECTION ViolnSection 11 67 40 48

STRINGS/
BRASS

012 ORCHESTRA PAD OrchestraPad 12 67 48 52

STRINGS/
BRASS

013 CHOIR Choir 13 67 52 48

STRINGS/
BRASS

014 SYNTH-VOICE 1 Synth-Voice1 14 67 54 48

STRINGS/
BRASS

015 SYNTH-VOICE 2 Synth-Voice2 15 67 54 49

STRINGS/
BRASS

016 VOICE ENSEMBLE VoiceEnsembl 16 67 54 50

STRINGS/
BRASS

017 SYNTH-VOICE PAD SynVoice Pad 17 67 54 51

STRINGS/
BRASS

018 STEREO BRASS Stereo Brass 18 67 61 48

STRINGS/
BRASS

019 BRASS SECTION BrassSection 19 67 61 49

STRINGS/
BRASS

020 SYNTH-BRASS 1 Syn-Brass 1 20 67 62 48

STRINGS/
BRASS

021 SYNTH-BRASS 2 Syn-Brass 2 21 67 63 48

STRINGS/
BRASS

022 80’S SYNTH-BRASS 80’sSynBrass 22 67 62 49

STRINGS/
BRASS

023 BRASS ENSEMBLE Brass Ens. 23 67 61 50

STRINGS/
BRASS

024 BREATHY ALTO SAX Breathy ASax 24 67 65 49

STRINGS/
BRASS

025 BREATHY TENOR SAX Breathy TSax 25 67 66 49

STRINGS/
BRASS

026 ALTO SAX Alto Sax 26 67 65 48

STRINGS/
BRASS

027 TENOR SAX Tenor Sax 27 67 66 48

STRINGS/
BRASS

028 FLUTE Flute 28 67 73 48

STRINGS/
BRASS

029 TRUMPET Trumpet 29 67 56 48

STRINGS/
BRASS

030 GM VIOLIN GM Violin 30 67 40 0

STRINGS/
BRASS

031 GM VIOLA GM Viola 31 67 41 0

STRINGS/
BRASS

032 GM CELLO GM Cello 32 67 42 0

STRINGS/
BRASS

033 GM CONTRABASS GM Contrabas 33 67 43 0

STRINGS/
BRASS

034
GM TREMOLO 
STRINGS

GM Trem.Str. 34 67 44 0

STRINGS/
BRASS

035 GM PIZZICATO GM Pizzicato 35 67 45 0

STRINGS/
BRASS

036 GM HARP GM Harp 36 67 46 0

STRINGS/
BRASS

037 GM TIMPANI GM Timpani 37 67 47 0

STRINGS/
BRASS

038 GM STRINGS 1 GM Strings 1 38 67 48 0

STRINGS/
BRASS

039 GM STRINGS 2 GM Strings 2 39 67 49 0

STRINGS/
BRASS

040 GM SYNTH-STRINGS 1 GM Syn-Str.1 40 67 50 0

STRINGS/
BRASS

041 GM SYNTH-STRINGS 2 GM Syn-Str.2 41 67 51 0

STRINGS/
BRASS

042 GM CHOIR AAHS GM ChoirAahs 42 67 52 0
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STRINGS/
BRASS

043 GM VOICE DOO GM Voice Doo 43 67 53 0

STRINGS/
BRASS

044 GM SYNTH-VOICE GM Syn-Voice 44 67 54 0

STRINGS/
BRASS

045 GM ORCHESTRA HIT GM Orch.Hit 45 67 55 0

STRINGS/
BRASS

046 GM TRUMPET GM Trumpet 46 67 56 0

STRINGS/
BRASS

047 GM TROMBONE GM Trombone 47 67 57 0

STRINGS/
BRASS

048 GM TUBA GM Tuba 48 67 58 0

STRINGS/
BRASS

049 GM MUTE TRUMPET GM MtTrumpet 49 67 59 0

STRINGS/
BRASS

050 GM FRENCH HORN GM Fr.Horn 50 67 60 0

STRINGS/
BRASS

051 GM BRASS GM Brass 51 67 61 0

STRINGS/
BRASS

052 GM SYNTH-BRASS 1 GM SynBrass1 52 67 62 0

STRINGS/
BRASS

053 GM SYNTH-BRASS 2 GM SynBrass2 53 67 63 0

STRINGS/
BRASS

054 GM SOPRANO SAX GM Sop.Sax 54 67 64 0

STRINGS/
BRASS

055 GM ALTO SAX GM Alto Sax 55 67 65 0

STRINGS/
BRASS

056 GM TENOR SAX GM Tenor Sax 56 67 66 0

STRINGS/
BRASS

057 GM BARITONE SAX GM Bar.Sax 57 67 67 0

STRINGS/
BRASS

058 GM OBOE GM Oboe 58 67 68 0

STRINGS/
BRASS

059 GM ENGLISH HORN GM Eng.Horn 59 67 69 0

STRINGS/
BRASS

060 GM BASSOON GM Bassoon 60 67 70 0

STRINGS/
BRASS

061 GM CLARINET GM Clarinet 61 67 71 0

STRINGS/
BRASS

062 GM PICCOLO GM Piccolo 62 67 72 0

STRINGS/
BRASS

063 GM FLUTE GM Flute 63 67 73 0

STRINGS/
BRASS

064 GM RECORDER GM Recorder 64 67 74 0

STRINGS/
BRASS

065 GM PAN FLUTE GM Pan Flute 65 67 75 0

STRINGS/
BRASS

066 GM BOTTLE BLOW GM BotleBlow 66 67 76 0

STRINGS/
BRASS

067 GM SHAKUHACHI GM Shakuhach 67 67 77 0

STRINGS/
BRASS

068 GM WHISTLE GM Whistle 68 67 78 0

STRINGS/
BRASS

069 GM OCARINA GM Ocarina 69 67 79 0

STRINGS/
BRASS

070 - 
089

User Tones 70 - 89 67

GUITAR/
BASS

000 ACOUSTIC BASS 1 Acous.Bass 1 0 68 32 48

GUITAR/
BASS

001 ACOUSTIC BASS 2 Acous.Bass 2 1 68 32 49

GUITAR/
BASS

002 RIDE BASS Ride Bass 2 68 32 50

GUITAR/
BASS

003 FINGERED BASS 1 FingerBass 1 3 68 33 48

GUITAR/
BASS

004 FINGERED BASS 2 FingerBass 2 4 68 33 49

GUITAR/
BASS

005 FINGERED BASS 3 FingerBass 3 5 68 34 50

GUITAR/
BASS

006 PICKED BASS Picked Bass 6 68 34 48

GUITAR/
BASS

007 SYNTH-BASS 1 Synth-Bass 1 7 68 38 48

GUITAR/
BASS

008 SYNTH-BASS 2 Synth-Bass 2 8 68 38 49

GUITAR/
BASS

009 SYNTH-BASS 3 Synth-Bass 3 9 68 38 50

GUITAR/
BASS

010 SYNTH-BASS 4 Synth-Bass 4 10 68 39 48

GUITAR/
BASS

011 SYNTH-BASS 5 Synth-Bass 5 11 68 39 49

GUITAR/
BASS

012 SYNTH-BASS 6 Synth-Bass 6 12 68 39 50

GUITAR/
BASS

013 TRANCE BASS Trance Bass 13 68 38 51

GUITAR/
BASS

014 NYLON STR.GUITAR Nylon Guitar 14 68 24 48

GUITAR/
BASS

015 STEEL STR.GUITAR Steel Guitar 15 68 25 48

GUITAR/
BASS

016 JAZZ GUITAR Jazz Guitar 16 68 26 48

GUITAR/
BASS

017 CLEAN GUITAR Clean Guitar 17 68 27 49

GUITAR/
BASS

018
CHORUS CLEAN 
GUITAR

Cho.CleanGt 18 68 27 48

GUITAR/
BASS

019
CRUNCH 
ELEC.GUITAR

Crunch E.Gt 19 68 27 50
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GUITAR/
BASS

020 OVERDRIVE GUITAR 1 Overdrive Gt 20 68 29 48

GUITAR/
BASS

021 MUTE OVERDRIVE GT Mute Ovd Gt 21 68 28 48

GUITAR/
BASS

022 OVERDRIVE GUITAR 2 Overdrive G2 22 68 28 49

GUITAR/
BASS

023 DISTORTION GT DistortionGt 23 68 30 48

GUITAR/
BASS

024
GM NYLON 
STR.GUITAR

GM Nylon Gt 24 68 24 0

GUITAR/
BASS

025
GM STEEL 
STR.GUITAR

GM Steel Gt 25 68 25 0

GUITAR/
BASS

026 GM JAZZ GUITAR GM Jazz Gt 26 68 26 0

GUITAR/
BASS

027 GM CLEAN GUITAR GM Clean Gt 27 68 27 0

GUITAR/
BASS

028 GM MUTE GUITAR GM Mute Gt 28 68 28 0

GUITAR/
BASS

029 GM OVERDRIVE GT GM Overdrive 29 68 29 0

GUITAR/
BASS

030 GM DISTORTION GT GM Dist.Gt 30 68 30 0

GUITAR/
BASS

031 GM GT HARMONICS GM Gt Harm. 31 68 31 0

GUITAR/
BASS

032 GM ACOUSTIC BASS GM AcousBass 32 68 32 0

GUITAR/
BASS

033 GM FINGERED BASS GM Finger Bs 33 68 33 0

GUITAR/
BASS

034 GM PICKED BASS GM Pick Bass 34 68 34 0

GUITAR/
BASS

035 GM FRETLESS BASS GM FretlesBs 35 68 35 0

GUITAR/
BASS

036 GM SLAP BASS 1 GM SlapBass1 36 68 36 0

GUITAR/
BASS

037 GM SLAP BASS 2 GM SlapBass2 37 68 37 0

GUITAR/
BASS

038 GM SYNTH-BASS 1 GM Syn-Bass1 38 68 38 0

GUITAR/
BASS

039 GM SYNTH-BASS 2 GM Syn-Bass2 39 68 39 0

GUITAR/
BASS

040 - 
059

User Tones 40 - 59 68

SYNTH/
VARIOUS

000 SAW LEAD 1 Saw Lead 1 0 69 81 48

SYNTH/
VARIOUS

001 SAW LEAD 2 Saw Lead 2 1 69 81 49

SYNTH/
VARIOUS

002 SAW LEAD 3 Saw Lead 3 2 69 81 50

SYNTH/
VARIOUS

003 MELLOW SAW LEAD MelowSawLead 3 69 81 51

SYNTH/
VARIOUS

004 SQUARE LEAD 1 Square Lead1 4 69 80 48

SYNTH/
VARIOUS

005 SQUARE LEAD 2 Square Lead2 5 69 80 49

SYNTH/
VARIOUS

006 PULSE LEAD 1 Pulse Lead 1 6 69 80 51

SYNTH/
VARIOUS

007 PULSE LEAD 2 Pulse Lead 2 7 69 80 52

SYNTH/
VARIOUS

008 SINE LEAD Sine Lead 8 69 80 53

SYNTH/
VARIOUS

009
SQUARE PULSE 
LEAD

Sqr Pulse Ld 9 69 80 59

SYNTH/
VARIOUS

010 VA SYNTH 1 VA Synth 1 10 69 80 54

SYNTH/
VARIOUS

011 VA SYNTH 2 VA Synth 2 11 69 80 55

SYNTH/
VARIOUS

012 VA SYNTH 3 VA Synth 3 12 69 80 56

SYNTH/
VARIOUS

013 VA SYNTH 4 VA Synth 4 13 69 80 57

SYNTH/
VARIOUS

014 VA SYNTH 5 VA Synth 5 14 69 80 58

SYNTH/
VARIOUS

015 SEQUENCE SAW Sequence Saw 15 69 81 55

SYNTH/
VARIOUS

016 SAW ARPEGGIO Saw Arpeggio 16 69 81 56

SYNTH/
VARIOUS

017
VA SYNTH 
SEQ-BASS 1

VA SynSeqBs1 17 69 81 52

SYNTH/
VARIOUS

018
VA SYNTH 
SEQ-BASS 2

VA SynSeqBs2 18 69 81 53

SYNTH/
VARIOUS

019
VA SYNTH 
SEQ-BASS 3

VA SynSeqBs3 19 69 81 54

SYNTH/
VARIOUS

020 FANTASY Fantasy 20 69 88 48

SYNTH/
VARIOUS

021 NEW AGE New Age 21 69 88 49

SYNTH/
VARIOUS

022 WARM PAD Warm Pad 22 69 89 48

SYNTH/
VARIOUS

023 WARM VOX Warm Vox 23 69 89 49

SYNTH/
VARIOUS

024 POLYSYNTH PAD PolysynthPad 24 69 90 48

SYNTH/
VARIOUS

025 SYNTH-PAD Syn-Pad 25 69 90 49

SYNTH/
VARIOUS

026 BRIGHT SAW PAD BrightSawPad 26 69 90 50
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SYNTH/
VARIOUS

027 ATMOSPHERE PAD AtmspherePad 27 69 99 48

SYNTH/
VARIOUS

028 VA SYNTH-PAD 1 VA Syn-Pad 1 28 69 90 51

SYNTH/
VARIOUS

029 VA SYNTH-PAD 2 VA Syn-Pad 2 29 69 90 52

SYNTH/
VARIOUS

030 VA SYNTH-PAD 3 VA Syn-Pad 3 30 69 90 53

SYNTH/
VARIOUS

031 GM SQUARE LEAD GM Squ.Lead 31 69 80 0

SYNTH/
VARIOUS

032 GM SAW LEAD GM Saw Lead 32 69 81 0

SYNTH/
VARIOUS

033 GM CALLIOPE GM Calliope 33 69 82 0

SYNTH/
VARIOUS

034 GM CHIFF LEAD GM ChiffLead 34 69 83 0

SYNTH/
VARIOUS

035 GM CHARANG GM Charang 35 69 84 0

SYNTH/
VARIOUS

036 GM VOICE LEAD GM VoiceLead 36 69 85 0

SYNTH/
VARIOUS

037 GM FIFTH LEAD GM FifthLead 37 69 86 0

SYNTH/
VARIOUS

038 GM BASS+LEAD GM Bass+Lead 38 69 87 0

SYNTH/
VARIOUS

039 GM FANTASY GM Fantasy 39 69 88 0

SYNTH/
VARIOUS

040 GM WARM PAD GM Warm Pad 40 69 89 0

SYNTH/
VARIOUS

041 GM POLYSYNTH GM PolySynth 41 69 90 0

SYNTH/
VARIOUS

042 GM SPACE CHOIR GM Space Cho 42 69 91 0

SYNTH/
VARIOUS

043 GM BOWED GLASS GM Bow Glass 43 69 92 0

SYNTH/
VARIOUS

044 GM METAL PAD GM Metal Pad 44 69 93 0

SYNTH/
VARIOUS

045 GM HALO PAD GM Halo Pad 45 69 94 0

SYNTH/
VARIOUS

046 GM SWEEP PAD GM Sweep Pad 46 69 95 0

SYNTH/
VARIOUS

047 GM RAIN DROP GM Rain Drop 47 69 96 0

SYNTH/
VARIOUS

048 GM SOUND TRACK GM SoundTrak 48 69 97 0

SYNTH/
VARIOUS

049 GM CRYSTAL GM Crystal 49 69 98 0

SYNTH/
VARIOUS

050 GM ATMOSPHERE GM Atmosphre 50 69 99 0

SYNTH/
VARIOUS

051 GM BRIGHTNESS GM Brightnes 51 69 100 0

SYNTH/
VARIOUS

052 GM GOBLINS GM Goblins 52 69 101 0

SYNTH/
VARIOUS

053 GM ECHOES GM Echoes 53 69 102 0

SYNTH/
VARIOUS

054 GM SF GM SF 54 69 103 0

SYNTH/
VARIOUS

055 GM SITAR GM Sitar 55 69 104 0

SYNTH/
VARIOUS

056 GM BANJO GM Banjo 56 69 105 0

SYNTH/
VARIOUS

057 GM SHAMISEN GM Shamisen 57 69 106 0

SYNTH/
VARIOUS

058 GM KOTO GM Koto 58 69 107 0

SYNTH/
VARIOUS

059 GM THUMB PIANO GM Thumb Pno 59 69 108 0

SYNTH/
VARIOUS

060 GM BAGPIPE GM Bagpipe 60 69 109 0

SYNTH/
VARIOUS

061 GM FIDDLE GM Fiddle 61 69 110 0

SYNTH/
VARIOUS

062 GM SHANAI GM Shanai 62 69 111 0

SYNTH/
VARIOUS

063 GM DULCIMER GM Dulcimer 63 69 15 0

SYNTH/
VARIOUS

064 GM TINKLE BELL GM TinkleBel 64 69 112 0

SYNTH/
VARIOUS

065 GM AGOGO GM Agogo 65 69 113 0

SYNTH/
VARIOUS

066 GM STEEL DRUMS GM SteelDrum 66 69 114 0

SYNTH/
VARIOUS

067 GM WOOD BLOCK GM WoodBlock 67 69 115 0

SYNTH/
VARIOUS

068 GM TAIKO GM Taiko 68 69 116 0

SYNTH/
VARIOUS

069 GM MELODIC TOM GM Melo.Tom 69 69 117 0

SYNTH/
VARIOUS

070 GM SYNTH-DRUM GM Syn-Drum 70 69 118 0

SYNTH/
VARIOUS

071
GM REVERSE 
CYMBAL

GM RevCymbal 71 69 119 0

SYNTH/
VARIOUS

072 GM GT FRET NOISE GM GtFrNoise 72 69 120 0

SYNTH/
VARIOUS

073 GM BREATH NOISE GM BrthNoise 73 69 121 0

SYNTH/
VARIOUS

074 GM SEASHORE GM Seashore 74 69 122 0
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NOTE

• See the “Drum Assignment List” (page E-46) for the 
percussion instrument assigned to each keyboard 
key when a drum set (“DRUMS“) is selected.

SYNTH/
VARIOUS

075 GM BIRD GM Bird 75 69 123 0

SYNTH/
VARIOUS

076 GM TELEPHONE GM Telephone 76 69 124 0

SYNTH/
VARIOUS

077 GM HELICOPTER GM Helicoptr 77 69 125 0

SYNTH/
VARIOUS

078 GM APPLAUSE GM Applause 78 69 126 0

SYNTH/
VARIOUS

079 GM GUNSHOT GM Gunshot 79 69 127 0

SYNTH/
VARIOUS

080 - 
127

User Tones 80 - 127 69

SYNTH/
VARIOUS

128 - 
129

User Tones 0 - 1 70

DRUMS 000 STANDARD SET 1 StandardSet1 0 125 0 120

DRUMS 001 STANDARD SET 2 StandardSet2 1 125 1 120

DRUMS 002 STANDARD SET 3 StandardSet3 2 125 2 120

DRUMS 003 STANDARD SET 4 StandardSet4 3 125 3 120

DRUMS 004 DANCE SET 1 Dance Set 1 4 125 26 120

DRUMS 005 DANCE SET 2 Dance Set 2 5 125 27 120

DRUMS 006 DANCE SET 3 Dance Set 3 6 125 28 120

DRUMS 007 TRANCE SET Trance Set 7 125 29 120

DRUMS 008 HIP-HOP SET Hip-Hop Set 8 125 9 120

DRUMS 009 ROOM SET Room Set 9 125 8 120

DRUMS 010 POWER SET Power Set 10 125 16 120

DRUMS 011 ROCK SET Rock Set 11 125 17 120

DRUMS 012 ELECTRONIC SET Elec.Set 12 125 24 120

DRUMS 013 SYNTH SET 1 Synth Set 1 13 125 25 120

DRUMS 014 SYNTH SET 2 Synth Set 2 14 125 30 120

DRUMS 015 JAZZ SET Jazz Set 15 125 32 120

DRUMS 016 BRUSH SET Brush Set 16 125 40 120

DRUMS 017 ORCHESTRA SET OrchestraSet 17 125 48 120

DRUMS 018 ETHNIC SET 1 Ethnic Set 1 18 125 49 120

DRUMS 019 ETHNIC SET 2 Ethnic Set 2 19 125 50 120

DRUMS
020 - 
039

User Drums 20 - 39 125

HEX 
LAYER

000 PX HEX TONE00 PX HexTone00 0 97

HEX 
LAYER

001 PX HEX TONE01 PX HexTone01 1 97

HEX 
LAYER

002 PX HEX TONE02 PX HexTone02 2 97

HEX 
LAYER

003 PX HEX TONE03 PX HexTone03 3 97

HEX 
LAYER

004 PX HEX TONE04 PX HexTone04 4 97

HEX 
LAYER

005 PX HEX TONE05 PX HexTone05 5 97

HEX 
LAYER

006 PX HEX TONE06 PX HexTone06 6 97

HEX 
LAYER

007 PX HEX TONE07 PX HexTone07 7 97

HEX 
LAYER

008 PX HEX TONE08 PX HexTone08 8 97

HEX 
LAYER

009 PX HEX TONE09 PX HexTone09 9 97

HEX 
LAYER

010 ICECASTLES Ice Castles 10 97

HEX 
LAYER

011 HOUSETOP House Top 11 97

HEX 
LAYER

012 MAXIMUM Maximum 12 97

HEX 
LAYER

013 MIDNIGHTSUN Midnight Sun 13 97

HEX 
LAYER

014 ORCHESTRA Orchestra 14 97

HEX 
LAYER

015 PX-PAD PX-Pad 15 97

HEX 
LAYER

016 ALORE YE Alore Ye 16 97

HEX 
LAYER

017 TRANSEDSAW Transed Saw 17 97

HEX 
LAYER

018 HEX SYNBRASS Hex SynBrass 18 97

HEX 
LAYER

019 HEX SYNVOICES HexSynVoices 19 97

HEX 
LAYER

020 HEX MFPIANO Hex Mf Piano 20 97

HEX 
LAYER

021 HEX JUNGLEPF Hex JunglePf 21 97

HEX 
LAYER

022 HEX BASIC EP1 Hex BasicEP1 22 97

HEX 
LAYER

023 HEX BASIC EP2 Hex BasicEP2 23 97

HEX 
LAYER

024 HEX BASIC EP3 Hex BasicEP3 24 97

HEX 
LAYER

025 HEX BASIC EP4 Hex BasicEP4 25 97

HEX 
LAYER

026 HEX BASIC EP5 Hex BasicEP5 26 97

HEX 
LAYER

027 HEX BASIC EP6 Hex BasicEP6 27 97

HEX 
LAYER

028 HEX ELEC.CLAV1 Hex EleClav1 28 97

Group 
Name Number Tone Name Screen Name

Sending and Receiving Receiving Only

Program 
Change

Bank 
Select 
MSB

Program 
Change

Bank 
Select 
MSB

HEX 
LAYER

029 HEX ELEC.CLAV2 Hex EleClav2 29 97

HEX 
LAYER

030 HEX ENSEMBLE1 HexEnsemble1 30 97

HEX 
LAYER

031 HEX ENSEMBLE2 HexEnsemble2 31 97

HEX 
LAYER

032 HEX PIPE ORGAN HexPipeorgan 32 97

HEX 
LAYER

033 HEX SAX LAYER Hex SaxLayer 33 97

HEX 
LAYER

034 HEX WOOD LAYER HexWoodLayer 34 97

HEX 
LAYER

035 HEX REED LAYER HexReedLayer 35 97

HEX 
LAYER

036 HEX TOP OCTAVE HexTopOctave 36 97

HEX 
LAYER

037 HEX PICK LAYER HexPickLayer 37 97

HEX 
LAYER

038 HEX SPLIT1 Hex Split1 38 97

HEX 
LAYER

039 HEX SPLIT2 Hex Split2 39 97

HEX 
LAYER

040 HEX SYN-LEAD1 Hex SynLead1 40 97

HEX 
LAYER

041 HEX SYN-LEAD2 Hex SynLead2 41 97

HEX 
LAYER

042 HEX SYN-LEAD3 Hex SynLead3 42 97

HEX 
LAYER

043 HEX SYN-LEAD4 Hex SynLead4 43 97

HEX 
LAYER

044 HEX SYN-LEAD5 Hex SynLead5 44 97

HEX 
LAYER

045 HEX SYN-BASIC1 HexSynBasic1 45 97

HEX 
LAYER

046 HEX SYN-BASIC2 HexSynBasic2 46 97

HEX 
LAYER

047 HEX SYN-BASIC3 HexSynBasic3 47 97

HEX 
LAYER

048 HEX SYN-BASIC4 HexSynBasic4 48 97

HEX 
LAYER

049 HEX SYN-BASIC5 HexSynBasic5 49 97

HEX 
LAYER

050 - 
127

User HexLayer Tones 50 - 127 97

HEX 
LAYER

128 - 
199

User HexLayer Tones 0 - 71 98

Group 
Name Number Tone Name Screen Name

Sending and Receiving Receiving Only

Program 
Change

Bank 
Select 
MSB

Program 
Change

Bank 
Select 
MSB
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E-46

Reference

• ” ”indicates a key is assigned the same tones as it is for STANDARD SET 1.

Drum Assignment List
�

STANDARD SET 1 STANDARD SET 2

C-1

D-1

E-1

F-1

G-1

A-1

B-1

C0

D0

E0

F0

G0

A0

B0

C1

D1

E1

F1

G1

A1

B1

C2

D2

E2

F2

G2

A2

B2

C3

D3

E3

F3

G3

A3

B3

C4

D4

E4

F4

G4

A4

B4

C5

D5

E5

F5

G5

A5

B5

C6

D6

E6

F6

G6

A6

B6

C7

D7

E7

F7

G7

A7

B7

C8

D8

E8

F8

G8

A8

B8

C9

D9

E9

F9

G9

C#-1

Eb-1

F#-1

Ab-1

Bb-1

C#0

Eb0

F#0

Ab0

Bb0

C#1

Eb1

F#1

Ab1

Bb1

C#2

Eb2

F#2

Ab2

Bb2

C#3

Eb3

F#3

Ab3

Bb3

C#4

Eb4

F#4

Ab4

Bb4

C#5

Eb5

F#5

Ab5

Bb5

C#6

Eb6

F#6

Ab6

Bb6

C#7

Eb7

F#7

Ab7

Bb7

C#8

Eb8

F#8

Ab8

Bb8

C#9

Eb9

F#9

STANDARD SET 4STANDARD SET 3 DANCE SET 1 DANCE SET 2 DANCE SET 3

0
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99

100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127

Tabla Ge
Tabla Ka
Tabla Te
Tabla Na
Tabla Tun
Dholak Ge
Dholak Ke
Dholak Ta 1
Dholak Ta 2
Dholak Na
Dholak Ta 3
Dholak Ring
Mridangam Tha
Mridangam Dhom
Mridangam Dhi
Mridangam Dhin
Mridangam Num

High Q
Slap
Scratch Push
Scratch Pull
Sticks
Square Click
Metronome Click
Metronome Bell
Standard1 Kick 2
Standard1 Kick 1
Side Stick
Standard1 Snare 1
Hand Clap
Standard1 Snare 2
Low Tom 2
Closed Hi-Hat
Low Tom 1
Pedal Hi-Hat
Mid Tom 2
Open Hi-Hat
Mid Tom 1
High Tom 2
Crash Cymbal 1
High Tom 1
Ride Cymbal 1
Chinese Cymbal
Ride Bell
Tambourine
Splash Cymbal
Cowbell
Crash Cymbal 2
Vibraslap
Ride Cymbal 2
High Bongo
Low Bongo
Mute High Conga
Open High Conga
Open Low Conga
High Timbale
Low Timbale
High Agogo
Low Agogo
Cabasa
Maracas
Short High Whistle
Long Low Whistle
Short Guiro
Long Guiro
Claves
High Wood Block
Low Wood Block
Mute Cuica
Open Cuica
Mute Triangle
Open Triangle
Shaker
Jingle Bell
Bell Tree
Castanets
Mute Surdo
Open Surdo
Applause 1
Applause 2

Tablah 1
Tablah 2
Tablah 3
Daf 1
Daf 2
Riq 1
Riq 2
Riq 3
Davul 1
Davul 2
Zill 1
Zill 2
Ban Gu
Hu Yin Luo
Xiao Luo
Xiao Bo
Low Tang Gu
Mid Tang Gu
High Tang Gu

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Standard2 Kick 2
Standard2 Kick 1
�

Standard2 Snare 1
�

Standard2 Snare 2
�

Standard2 Closed Hi-Hat
�

Standard2 Pedal Hi-Hat
�

Standard2 Open Hi-Hat
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Standard3 Kick 2
Standard3 Kick 1
Standard3 Side Stick
Standard3 Snare 1
Standard3 Hand Clap
Standard3 Snare 2
Standard3 Low Tom 2
Standard3 Closed Hi-Hat
Standard3 Low Tom 1
Standard3 Pedal Hi-Hat
Standard3 Mid Tom 2
Standard3 Open Hi-Hat
Standard3 Mid Tom 1
Standard3 High Tom 2
�

Standard3 High Tom 1
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Standard4 Kick 2
Standard4 Kick 1
�

Standard4 Snare 1
�

Standard4 Snare 2
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Dance Kick 1
Dance Kick 2
Dance Kick 3
Dance Kick 4
Dance Kick 5
Dance Snare 1
Dance Snare 2
Dance Snare 3
Dance Snare 4
Dance Snare 5
Dance Snare 6
Dance Snare 7
Dance Snare 8
Dance Snare 9
Dance Tambourine
Hip-Hop Snare 4
Hip-Hop Snare 3
Techno Snare
Hip-Hop Rim Shot
Hip-Hop Snare 3 Rev.
Synth2 Kick 1 Rev.
Reverse Cymbal Gate
Hip-Hop Snare 4 Gate
Hip-Hop Snare 3 Gate
Techno Snare Gate
Hip-Hop Side Stick Gate
Hand Clap 2 Gate
�

�

Hip-Hop Scratch 1
Hip-Hop Scratch 2
�

�

�

�

Synth2 Kick 2
Synth2 Kick 1
�

Synth2 Snare 1
�

Synth2 Snare 2
Synth2 Low Tom 2
Synth2 Closed Hi-Hat 1
Synth2 Low Tom 1
Synth2 Closed Hi-Hat 2
Synth2 Mid Tom 2
Synth2 Open Hi-Hat
Synth2 Mid Tom 1
Synth2 Hi Tom 2
�

Synth2 Hi Tom 1
�

�

�

�

�

�

Synth2 Cymbal 2
�

Synth1 Kick 2
Synth1 Kick 1
Synth1 Rim Shot
Synth1 Snare 1
Synth1 Hand Clap
Synth1 Snare 2
Synth1 Low Tom 2
Synth1 Chh
Synth1 Low Tom 1
Synth1 Phh
Synth1 Mid Tom 2
Synth1 Ohh
Synth1 Mid Tom 1
Synth1 Hi Tom 2
Synth1 Cymbal
Synth1 Hi Tom 1
Synth1 Ride
Chinese Cymbal
Ride Bell
Synth 1 Tambourine
Splash Cymbal
Synth 1 Cowbell
Crash Cymbal 2
Vibraslap
Synth1 Kick 3
Hip-Hop Kick 3
Standard2 Kick 1
Standard2 Snare 1
Hand Clap 3
Standard2 Snare 2
Elec Low Tom 2
Hip-Hop Closed Hi-Hat
Elec Low Tom 1
Hip-Hop Pedal Hi-Hat
Elec Mid Tom 2
Hip-Hop Open Hi-Hat
Elec Mid Tom 1
Elec Hi Tom 2
Techno Cymbal
Elec Hi Tom 1
Techno Ride

Low Tom 2
Closed Hi-Hat
Low Tom 1
Pedal Hi-Hat
Mid Tom 2
Open Hi-Hat
Mid Tom 1
High Tom 2
Crash Cymbal 1
High Tom 1
Ride Cymbal 1

Tambourine 2
Tambourine 3
Cabasa 2
Maracas 2
Claves 2
Mute Triangle 2
Open Triangle 2
Shaker 2
Hand Clap
Hand Clap 2

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Hip-Hop Kick 3
Dance Kick 5
Hand Clap 3
Dance Snare 7
Hand Clap 2
Techno Snare
Synth2 Low Tom 2
Trance Closed Hi-Hat
Synth2 Low Tom 1
Trance Open Hi-Hat 1
Synth2 Mid Tom 2
Trance Open Hi-Hat 2
Synth2 Mid Tom 1
Synth2 High Tom 2
�

Synth2 High Tom 1
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Dance Kick 2
Dance Kick 4
Hip-Hop Side Stick Gate
Dance Snare 2
Synth1 Hand Clap
Dance Snare 1 Gate
Standard3 Low Tom 2
Standard3 Closed Hi-Hat
Standard3 Low Tom 1
Standard3 Pedal Hi-Hat
Standard3 Mid Tom 2
Standard3 Open Hi-Hat
Standard3 Mid Tom 1
Standard3 High Tom 2
�

Standard3 High Tom 1
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Key Note 
No.
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Reference

E-47

TRANCE SET HIP-HOP SET

C-1

D-1

E-1

F-1

G-1

A-1

B-1

C0

D0

E0

F0

G0

A0

B0

C1

D1

E1

F1

G1

A1

B1

C2

D2

E2

F2

G2

A2

B2

C3

D3

E3

F3

G3

A3

B3

C4

D4

E4

F4

G4

A4

B4

C5

D5

E5

F5

G5

A5

B5

C6

D6

E6

F6

G6

A6

B6

C7

D7

E7

F7

G7

A7

B7

C8

D8

E8

F8

G8

A8

B8

C9

D9

E9

F9

G9

C#-1

Eb-1

F#-1

Ab-1

Bb-1

C#0

Eb0

F#0

Ab0

Bb0

C#1

Eb1

F#1

Ab1

Bb1

C#2

Eb2

F#2

Ab2

Bb2

C#3

Eb3

F#3

Ab3

Bb3

C#4

Eb4

F#4

Ab4

Bb4

C#5

Eb5

F#5

Ab5

Bb5

C#6

Eb6

F#6

Ab6

Bb6

C#7

Eb7

F#7

Ab7

Bb7

C#8

Eb8

F#8

Ab8

Bb8

C#9

Eb9

F#9

POWER SETROOM SET ROCK SET ELECTRONIC SET SYNTH SET 1

0
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99

100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Trance Kick 2
Trance Kick 1
Trance Side Stick
Trance Snare 1
Trance Hand Clap
Trance Snare 2
�

Trance Closed Hi-Hat
�

Trance Open Hi-Hat 1
�

Trance Open Hi-Hat 2
�

�

�

�

�

�

�

Trance Tambourine
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Hip-Hop Kick 2
Hip-Hop Kick 1
Hip-Hop Side Stick
Hip-Hop Snare 1
Hip-Hop Hand Clap
Hip-Hop Snare 2
�

Hip-Hop Closed Hi-Hat
�

Hip-Hop Pedal Hi-Hat
�

Hip-Hop Open Hi-Hat
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�
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�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Room Kick 2
Room Kick 1
�

Room Snare 1
�

Room Snare 2
Room Low Tom 2
�

Room Low Tom 1
�

Room Mid Tom 2
�

Room Mid Tom 1
Room High Tom 2
�

Room High Tom 1
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�
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�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Power Kick 2
Power Kick 1
�

Power Snare 1
�

Power Snare 2
Room Low Tom 2
�

Room Low Tom 1
�

Room Mid Tom 2
�

Room Mid Tom 1
Room High Tom 2
�

Room High Tom 1
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�
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�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Rock Kick 2
Rock Kick 1
Rock Side Stick
Rock Snare 1
�

Rock Snare 2
�

Rock Closed Hi-Hat
�

Rock Pedal Hi-Hat
�

Rock Open Hi-Hat
�

�

Rock Crash Cymbal
�

Rock Ride Cymbal
�

�

�

Rock Splash Cymbal
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�
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�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Elec. Kick 2
Elec. Kick 1
�

Elec. Snare 1
�

Elec. Snare 2
Elec. Low Tom 2
�

Elec. Low Tom 1
�

Elec. Mid Tom 2
�

Elec. Mid Tom 1
Elec. High Tom 2
�

Elec. High Tom 1
�

Reverse Cymbal
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�
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�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Synth1 Kick 2
Synth1 Kick 1
Synth1 Rim Shot
Synth1 Snare 1
Synth1 Hand Clap
Synth1 Snare 2
Synth1 Low Tom 2
Synth1 Closed Hi-Hat 1
Synth1 Low Tom 1
Synth1 Closed Hi-Hat 2
Synth1 Mid Tom 2
Synth1 Open Hi-Hat
Synth1 Mid Tom 1
Synth1 High Tom 2
Synth1 Crash Cymbal
Synth1 High Tom 1
Synth1 Ride Cymbal
�

�

Synth1 Tambourine
�

Synth1 Cowbell
�

�

�

Synth1 High Bongo
Synth1 Low Bongo
Synth1 Mute Hi Conga
Synth1 Open Hi Conga
Synth1 Open Low Conga
�

�

�

�

�

Synth1 Maracas
�

�

�

�

Synth1 Claves
�

�

�
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�
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Key Note 
No.
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Reference

SYNTH SET 2 JAZZ SET

C-1

D-1

E-1

F-1

G-1

A-1

B-1

C0

D0

E0

F0

G0

A0

B0

C1

D1

E1

F1

G1

A1

B1

C2

D2

E2

F2

G2

A2

B2

C3

D3

E3

F3

G3

A3

B3

C4

D4

E4

F4

G4

A4

B4

C5

D5

E5

F5

G5

A5

B5

C6

D6

E6

F6

G6

A6

B6

C7

D7

E7

F7

G7

A7

B7

C8

D8

E8

F8

G8

A8

B8

C9

D9

E9

F9

G9

C#-1

Eb-1

F#-1

Ab-1

Bb-1

C#0

Eb0

F#0

Ab0

Bb0

C#1

Eb1

F#1

Ab1

Bb1

C#2

Eb2

F#2

Ab2

Bb2

C#3

Eb3

F#3

Ab3

Bb3

C#4

Eb4

F#4

Ab4

Bb4

C#5

Eb5

F#5

Ab5

Bb5

C#6

Eb6

F#6

Ab6

Bb6

C#7

Eb7

F#7

Ab7

Bb7

C#8

Eb8

F#8

Ab8

Bb8

C#9

Eb9

F#9

ORCHESTRA SETBRUSH SET ETHNIC SET 1 ETHNIC SET 2

0
1
2
3
4
5
6
7
8
9
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11
12
13
14
15
16
17
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27
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30
31
32
33
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35
36
37
38
39
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41
42
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56
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95
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99
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107
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112
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114
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�

Tabla Ge
Tabla Ka
Tabla Te
Tabla Na
Tabla Tun
Dholak Ge
Dholak Ke
Dholak Ta 1
Dholak Ta 2
Dholak Na
Dholak Ta 3
Dholak Ring
Mridangam Tha
Mridangam Dhom
Mridangam Dhi
Mridangam Dhin
Mridangam Num
�

�

�

�

�

�

�
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�
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�
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�

�

Tablah 1
Tablah 2
Tablah 3
Daf 1
Daf 2
Riq 1
Riq 2
Riq 3
Davul 1
Davul 2
Zill 1
Zill 2
Ban Gu
Hu Yin Luo
Xiao Luo
Xiao Bo
Low Tang Gu
Mid Tang Gu
High Tang Gu
�
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�

�
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Synth2 Kick 2
Synth2 Kick 1
Synth1 Rim Shot
Synth2 Snare 1
�

Synth2 Snare 2
Synth2 Low Tom 2
Synth2 Closed Hi-Hat 1
Synth2 Low Tom 1
Synth2 Closed Hi-Hat 2
Synth2 Mid Tom 2
Synth2 Open Hi-Hat
Synth2 Mid Tom 1
Synth2 High Tom 2
�

Synth2 High Tom 1
�

�

�

�

�

Synth1 Cowbell
�

�

�

�

�

�

�

�
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Synth1 Maracas
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Synth1 Claves
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Closed Hi-Hat
Pedal Hi-Hat
Open Hi-Hat
Ride Cymbal 1
�

�

�

�

Jazz Kick 1
Concert BD
�

Concert SD
Castanets
Concert SD
Timpani F
Timpani F #

Timpani G
Timpani G #

Timpani A
Timpani A #

Timpani B
Timpani c
Timpani c #

Timpani d
Timpani d #

Timpani e
Timpani f
�

�

�

Concert Cymbal 2
�

Concert Cymbal 1
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Jazz Kick 2
Brush Kick
Brush Side Stick
Brush Snare 1
Brush Slap
Brush Snare 2
�

�

�

�

�

�

�

�

Brush Crash Cymbal 1
�

Brush Ride Cymbal 1
�

Brush Ride Bell
Brush Tambourine
Brush Splash Cymbal
�

Brush Crash Cymbal 2
�

Brush Ride Cymbal 2
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Jazz Kick 2
Jazz Kick 1
 �
Jazz Snare 1
 �
Jazz Snare 2
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Key Note 
No.
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E-49

Arpeggio Type List

Number Type Name
000 Screw Up
001 Screw Down
002 Panning Up
003 Filtering
004 Skip Up
005 Skip Down
006 Up Up Down
007 Down Down Up
008 Step Arp 1
009 Step Arp 2
010 Seq Lines
011 Synth Seq 1
012 Synth Seq 2
013 Seq Line 1
014 Seq Line 2
015 Seq Line 3
016 Seq Line 4
017 Seq Line 5
018 Seq Line 6
019 Seq Line 7
020 Prelude
021 Arp 2 Oct
022 9th Arp 1
023 9th Arp 2
024 9th Arp 3
025 Soul Bass 1

026 Soul Bass 2
027 Shuffle Bass
028 Funk Bass
029 Bossa Bass
030 8 Beat Bass
031 R&B Bass
032 Bass Line 1
033 Bass Line 2
034 Scale 1
035 Scale 2
036 Scale 3
037 Scale 4
038 Blues Scale
039 Penta Scale
040 Funky EP
041 Ragtime
042 Riff
043 Ska
044 8 Beat
045 12/8
046 Shuffle
047 Waltz
048 Shuffle Pop
049 Hard Rock
050 Echo
051 Trill

Number Type Name
052 Poly 1
053 Poly 2
054 Poly 3
055 Poly 4
056 Poly 5
057 Poly 6
058 Poly 7
059 Poly 8
060 Up
061 Up 2Oct
062 Up 3Oct
063 Up 4Oct
064 Down
065 Down 2Oct
066 Down 3Oct
067 Down 4Oct
068 Up Down A
069 UpDownA 2Oct
070 UpDownA 3Oct
071 UpDownA 4Oct
072 Up Down B
073 UpDownB 2Oct
074 UpDownB 3Oct
075 UpDownB 4Oct
076 Random
077 Random 2Oct

Number Type Name
078 Random 3Oct
079 Random 4Oct
080 Repeat 1
081 Repeat 2
082 Add 5th Up
083 Add 5th Down
084 Add 5th U/D
085 5th Up 1
086 5th Up 2
087 Octave Up 1
088 Octave Up 2
089 Octave Down
090 Poly Up
091 Poly Down
092 Poly Line
093 4th Up
094 4th Down
095 New Age
096 Gtr Strk 1
097 Gtr Strk 2
098 Latin Pf 1
099 Latin Pf 2

Number Type Name

Wave List

Number Wave Name
0 GrPiano1-L
1 GrPiano1-R
2 GrPiano2-L
3 GrPiano2-R
4 GrPiano3-L
5 GrPiano3-R
6 GrPiano4-L
7 GrPiano4-R
8 PianoAttack1
9 PianoAttack2
10 PianoAttack3
11 AiR E.Piano1
12 AiR E.Piano2
13 AiR E.Piano3
14 AiR E.Piano4
15 AiR 60’s EP1
16 AiR 60’s EP2
17 AiR 60’s EP3
18 AiR 60’s EP4
19 ElecPiano1 1
20 ElecPiano1 2
21 ElecPiano2 1
22 ElecPiano2 2
23 ElecPiano2 3
24 60’sE.Piano1
25 60’sE.Piano2
26 E.Grand 80
27 DynoE.Piano1
28 DynoE.Piano2
29 FM E.Piano
30 MelowEPiano1
31 MelowEPiano2
32 Digital EP1A
33 Digital EP1B
34 Digital EP1C
35 Digital EP2A
36 Digital EP2B
37 Digital EP2C
38 Digital EP3A
39 Digital EP3B
40 Digital EP3C
41 Digital EP4
42 Analog EP1
43 Analog EP2
44 EP Attack1
45 EP Attack2

46 EP Attack3
47 EP Attack4
48 EP Attack5
49 EP Attack6
50 EP Attack7
51 EP Attack8
52 EP Attack9
53 EP Attack10
54 EP Attack11
55 EP Attack12
56 Clavi 1 1
57 Clavi 1 2
58 Clavi 2 1
59 Clavi 2 2
60 Clavi Off
61 ClaviAttack1
62 ClaviAttack2
63 Harpsichord
64 Harpsi Off
65 CouplHarpsi
66 Vibraphone
67 GM E.Piano11
68 GM E.Piano12
69 GM E.Piano2
70 GM Harpsi.
71 GM Clavi
72 GM Celesta
73 GM Glocken.
74 GM MusicBox1
75 GM MusicBox2
76 GM Vibraphon
77 GM Marimba
78 GM Xylophone
79 GM TublarBel
80 Rock Organ 1
81 RockOrgan2 1
82 RockOrgan2 2
83 Rock Organ 3
84 JazzOrgan1 1
85 JazzOrgan1 2
86 JazzOrgan2 1
87 JazzOrgan2 2
88 Perc.Organ 1
89 PercOrgan2 1
90 PercOrgan2 2
91 PercOrgan3 1

Number Wave Name
92 PercOrgan3 2
93 Drawbar Org1
94 Drawbar Org2
95 Drawbar Org3
96 Elec.Organ 1
97 Elec.Organ 2
98 Elec.Organ 3
99 70’s Organ

100 OverdriveOrg
101 Tremolo Org
102 Click Organ
103 Organ Click
104 8’Organ1
105 8’Organ2
106 Seq.Organ1
107 Seq.Organ2
108 ChurchOrgan1
109 ChurchOrgan2
110 Chapel Organ
111 GM Organ 1
112 GM Organ 21
113 GM Organ 22
114 GM Organ 31
115 GM Organ 32
116 GMPipeOrgan1
117 GMPipeOrgan2
118 GM ReedOrgan
119 GMAccordion1
120 GMAccordion2
121 GM Harmonica
122 GMBandoneon1
123 GMBandoneon2
124 StreoString1
125 StreoString2
126 String Ens.
127 Slow Strings
128 BritStrings1
129 BritStrings2
130 Warm Strings
131 SynStrings11
132 SynStrings12
133 Syn-Strings2
134 Syn-Strings3
135 70’s Syn-Str
136 80’s Syn-Str
137 ViolnSect1

Number Wave Name
138 ViolnSect2
139 OrchestrPad1
140 OrchestrPad2
141 Choir1
142 Choir2
143 Synth-Voice1
144 Synth-Voice2
145 VoiceEnsemb1
146 VoiceEnsemb2
147 SynVoice Pad
148 BrassSect1
149 BrassSect2
150 Syn-Brass 11
151 Syn-Brass 12
152 Syn-Brass 21
153 Syn-Brass 22
154 80sSynBrass1
155 80sSynBrass2
156 Brass Ens.1
157 Brass Ens.2
158 BreathyASax1
159 BreathyASax2
160 BreathyASax3
161 BreathyTSax1
162 BreathyTSax2
163 BreathyTSax3
164 GM Violin
165 GM Viola
166 GM Cello
167 GM Contrabas
168 GM Trem.Str.
169 GM Pizzicato
170 GM Harp
171 GM Timpani
172 GM Strings 1
173 GM Strings 2
174 GM Syn-Str.1
175 GM Syn-Str.2
176 GM ChoirAahs
177 GM Voice Doo
178 GM Syn-Voice
179 GM Orch.Hit1
180 GM Orch.Hit2
181 GM Trumpet1
182 GM Trumpet2
183 GM Trombone

Number Wave Name
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Reference

184 GM Tuba
185 GMMtTrumpet1
186 GMMtTrumpet2
187 GM Fr.Horn1
188 GM Fr.Horn2
189 GM Brass1
190 GM Brass2
191 GMSynBrass11
192 GMSynBrass12
193 GMSynBrass21
194 GMSynBrass22
195 GM Sop.Sax
196 GM Alto Sax
197 GM Tenor Sax
198 GM Bar.Sax
199 GM Oboe
200 GM Eng.Horn
201 GM Bassoon
202 GM Clarinet
203 GM Piccolo
204 GM Flute
205 GM Recorder
206 GM Pan Flute
207 GM BotleBlow
208 GMShakuhach1
209 GMShakuhach2
210 GM Whistle
211 GM Ocarina
212 AcousBass 11
213 AcousBass 12
214 AcousBass 13
215 AcousBass 21
216 AcousBass 22
217 AcousBass 23
218 Ride Bass
219 FingerBass 2
220 FingerBass 3
221 Picked Bass
222 Synth-Bass11
223 Synth-Bass12
224 Synth-Bass13
225 Synth-Bass14
226 Synth-Bass21
227 Synth-Bass22
228 Synth-Bass23
229 Synth-Bass24
230 Synth-Bass31
231 Synth-Bass32
232 Synth-Bass 4
233 Synth-Bass 5
234 Synth-Bass 6
235 Trance Bass1
236 Add FingBs1
237 Add FingBs2
238 Add FingBs3
239 Add PickBs1
240 Add PickBs2
241 Add SynBs1
242 Add SynBs2
243 Add SynBs3
244 SteelGuitr11
245 SteelGuitr12
246 Clean Guitar
247 Crunch E.Gt
248 OverdriveGt1
249 OverdriveGt2
250 Mute Ovd Gt
251 GM Nylon Gt1
252 GM Nylon Gt2
253 GM Steel Gt1
254 GM Steel Gt2
255 GM Jazz Gt
256 GM Clean Gt1
257 GM Clean Gt2
258 GM Mute Gt1
259 GM Mute Gt2
260 GMOverdrive1
261 GMOverdrive2
262 GM Dist.Gt
263 GM Gt Harm.
264 GMAcousBass1
265 GMAcousBass2
266 GMAcousBass3
267 GM FingerBs1
268 GM FingerBs2

Number Wave Name
269 GM PickBass1
270 GM PickBass2
271 GMFretlesBs1
272 GMFretlesBs2
273 GM SlapBass1
274 GMSlapBass21
275 GMSlapBass22
276 GM SynBass11
277 GM SynBass12
278 GM Syn-Bass2
279 Saw Lead 11
280 Saw Lead 12
281 Saw Lead 21
282 Saw Lead 22
283 Saw Lead 3
284 MelwSawLead1
285 MelwSawLead2
286 SquareLead11
287 SquareLead12
288 Square Lead2
289 PulseLead11
290 PulseLead12
291 PulseLead21
292 PulseLead22
293 Sine Lead
294 Sqr PulseLd1
295 Sqr PulseLd2
296 VA Synth 1
297 VA Synth 2
298 VA Synth 3
299 VA Synth 4
300 VA Synth 5
301 VA Synth 6
302 VA Synth 7
303 VA Synth 8
304 VA Synth 9
305 VA Synth 10
306 VA Synth 11
307 VA Synth 12
308 VA Synth 13
309 SequenceSaw1
310 SequenceSaw2
311 SawArpeggio1
312 SawArpeggio2
313 VA SynSeqBs1
314 VA SynSeqBs2
315 VA SynSeqBs3
316 Fantasy1
317 Fantasy2
318 New Age1
319 New Age2
320 Warm Pad
321 Warm Vox1
322 Warm Vox2
323 Syn-Bell Atk
324 SynVoice Atk
325 Syn-Pad1
326 Syn-Pad2
327 BrightSawPd1
328 BrightSawPd2
329 AtmspherePd1
330 AtmspherePd2
331 VA Syn-Pad 1
332 VA Syn-Pad 2
333 VA Syn-Pad 3
334 GM Squ.Lead1
335 GM Squ.Lead2
336 GM Saw Lead1
337 GM Saw Lead2
338 GM Calliope1
339 GM Calliope2
340 GMChiffLead1
341 GMChiffLead2
342 GM Charang1
343 GM Charang2
344 GMVoiceLead1
345 GMVoiceLead2
346 GMFifthLead1
347 GMFifthLead2
348 GMFifthLead3
349 GMFifthLead4
350 GMBass+Lead1
351 GMBass+Lead2
352 GMBass+Lead3
353 GMBass+Lead4

Number Wave Name
354 GM Fantasy1
355 GM Fantasy2
356 GM Warm Pad
357 GMPolySynth1
358 GMPolySynth2
359 GM SpaceCho1
360 GM SpaceCho2
361 GM BowGlass1
362 GM BowGlass2
363 GM MetalPad1
364 GM MetalPad2
365 GM Halo Pad1
366 GM Halo Pad2
367 GM Sweep Pad
368 GM RainDrop1
369 GM RainDrop2
370 GMSoundTrak1
371 GMSoundTrak2
372 GM Crystal1
373 GM Crystal2
374 GMAtmosphre1
375 GMAtmosphre2
376 GMBrightnes1
377 GMBrightnes2
378 GM Goblins1
379 GM Goblins2
380 GM Echoes
381 GM SF1
382 GM SF2
383 GM Sitar
384 GM Banjo
385 GM Shamisen
386 GM Koto
387 GM Thumb Pno
388 GM Bagpipe1
389 GM Bagpipe2
390 GM Fiddle
391 GM Shanai
392 GM Dulcimer
393 GM TinkleBel
394 GM Agogo
395 GMSteelDrum1
396 GMSteelDrum2
397 GM WoodBlock
398 GM Taiko
399 GM Melo.Tom
400 GM Syn-Drum
401 GM RevCymbal
402 GM GtFrNoise
403 GM BrthNoise
404 GM Seashore1
405 GM Seashore2
406 GM Bird1
407 GM Bird2
408 GM Telephone
409 GM Helicoptr
410 GM Applause1
411 GM Applause2
412 GM Gunshot
413 Sin Wave
414 SawtoothWave
415 Square Wave
416 Pulse Wave
417 White Noise
418 Pink Noise

Number Wave Name
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E-51

Instrument List

Number Wave Name
0 Blank Inst
1 Std1 Kick1
2 Std1 Kick2
3 Std2 Kick1
4 Std2 Kick2
5 Std3 Kick 1
6 Std3 Kick 2
7 Std4 Kick 1
8 Std4 Kick 2
9 HipHop Kick1
10 HipHop Kick2
11 HipHopKick3
12 Room Kick 1
13 Room Kick 2
14 Power Kick 1
15 Power Kick 2
16 Power Snare1
17 Power Snare2
18 Rock Kick 1
19 Rock Kick 2
20 Elec.Kick 1
21 Elec.Kick 2
22 Syn1 Kick 1
23 Syn1 Kick 2
24 Synth1Kick3
25 Syn2 Kick 1
26 Syn2 Kick 2
27 Syn2Kick1Rev
28 Trance Kick1
29 Trance Kick2
30 Dance Kick 1
31 Dance Kick 2
32 Dance Kick 3
33 Dance Kick 4
34 Dance Kick 5
35 Jazz Kick 1
36 Jazz Kick 2
37 Brush Kick 1
38 Concert BD
39 Std1 Snar1
40 Std1 Snar2
41 Std2Snare1
42 Std2Snare2
43 Std3 Snare 1
44 Std3 Snare 2
45 Std4 Snare 1
46 Std4 Snare 2
47 Room Snare 1
48 Room Snare 2
49 HipHopSnare1
50 HipHopSnare2
51 HipHopSnare3
52 HpHpSnar3Rev
53 HipHopSnare4
54 Rock Snare 1
55 Rock Snare 2
56 Elec.Snare 1
57 Elec.Snare 2
58 Syn1 Snare 1
59 Syn1 Snare 2
60 Syn2 Snare 1
61 Syn2 Snare 2
62 TranceSnare1
63 TranceSnare2
64 Dance Snare1
65 DanceSnar1Gt
66 Dance Snare2
67 Dance Snare3
68 Dance Snare4
69 Dance Snare5
70 Dance Snare6
71 Dance Snare7
72 Dance Snare8
73 Dance Snare9
74 Techno Snare
75 Jazz Snare 1
76 Jazz Snare 2
77 Brush Snare
78 Brush Slap
79 Brush Swirl
80 Concert SD

81 Side Stick
82 Std3SidStick
83 HpHpSidStick
84 RockSidStick
85 Syn1 RimShot
86 TrcSideStick
87 HpHp RimShot
88 BrshSidStick
89 Hand Clap
90 Std3HandClap
91 HipHpHndClap
92 Syn1HandClap
93 Trc HandClap
94 Hand Clap 2
95 Hand Clap 3
96 High Tom 1
97 High Tom 2
98 Mid Tom 1
99 Mid Tom 2

100 Low Tom 1
101 Low Tom 2
102 Std3HighTom1
103 Std3HighTom2
104 Std3MidTom1
105 Std3MidTom2
106 Std3LowTom1
107 Std3LowTom2
108 RoomHighTom1
109 RoomHighTom2
110 RoomMidTom1
111 RoomMidTom2
112 RoomLowTom1
113 RoomLowTom2
114 ElecHighTom1
115 ElecHighTom2
116 Elec.MidTom1
117 Elec.MidTom2
118 Elec.LowTom1
119 Elec.LowTom2
120 Syn1 HiTom1
121 Syn1 HiTom2
122 Syn1 MidTom1
123 Syn1 MidTom2
124 Syn1 LowTom1
125 Syn1 LowTom2
126 Syn2 HiTom1
127 Syn2 HiTom2
128 Syn2 MidTom1
129 Syn2 MidTom2
130 Syn2 LowTom1
131 Syn2 LowTom2
132 CloseHiHat
133 PedalHiHat
134 Open HiHat
135 Std2 CHHat
136 Std2 PHHat
137 Std2 OHHat
138 Std3 ClHiHat
139 Std3 PdHiHat
140 Std3 OpHiHat
141 HipHop CHHat
142 HipHop PHHat
143 HipHop OHHat
144 Rock ClHiHat
145 Rock PdHiHat
146 Rock OpHiHat
147 Syn1ClHiHat1
148 Syn1ClHiHat2
149 Syn1 OpHiHat
150 Syn2ClHiHat1
151 Syn2ClHiHat2
152 Syn2 OpHiHat
153 Trc ClsHiHat
154 Trc OpHiHat1
155 Trc OpHiHat2
156 CrashCymbal1
157 CrashCymbal2
158 RockCrashCym
159 ChineseCymbl
160 SplashCymbal
161 RockSplshCym

Number Wave Name
162 ReverseCymbl
163 Syn1CrashCym
164 TechnoCymbal
165 BrshCrshCym1
166 BrshCrshCym2
167 BrshSplshCym
168 RideCymbal 1
169 RideCymbal 2
170 Ride Bell
171 RockRideCymb
172 Syn1 RideCym
173 Techno Ride
174 BrshRideCym1
175 BrshRideCym2
176 BrshRideBell
177 Concert Cym1
178 Concert Cym2
179 High Q
180 Slap
181 Square Click
182 Sticks
183 Metron.Click
184 Metron.Bell
185 Scratch Push
186 Scratch Pull
187 HpHpScratch1
188 HpHpScratch2
189 Tambourin1
190 Tambourin2
191 Tambourin3
192 Syn1 Tambrin
193 TrcTambourin
194 DancTamborin
195 BrTambourn
196 Cowbell
197 Syn1 Cowbell
198 Vibraslap
199 High Bongo
200 Low Bongo
201 Syn1 HiBongo
202 Syn1LowBongo
203 Mute HiConga
204 Open HiConga
205 OpenLowConga
206 Syn1MtHiCong
207 Syn1OpHiCong
208 Syn1OpLoCong
209 High Timbale
210 Low Timbale
211 High Agogo
212 Low Agogo
213 Cabasa
214 Cabasa 2
215 Maracas
216 Maracas 2
217 Syn1 Maracas
218 ShrtHiWhistl
219 LongLoWhistl
220 Short Guiro
221 Long Guiro
222 Claves
223 Claves 2
224 Syn1 Claves
225 Hi WoodBlock
226 LowWoodBlock
227 Mute Cuica
228 Open Cuica
229 MuteTriangle
230 OpenTriangle
231 MuteTriangl2
232 OpenTriangl2
233 Shaker
234 Shaker 2
235 Jingle Bell
236 Bell Tree
237 Castanets
238 Mute Surdo
239 Open Surdo
240 Applause 1
241 Applause 2
242 Timpani F

Number Wave Name
243 Timpani F#
244 Timpani G
245 Timpani G#
246 Timpani A
247 Timpani A#
248 Timpani B
249 Timpani c+
250 Timpani c#+
251 Timpani d+
252 Timpani d#+
253 Timpani e+
254 Timpani f+
255 Tabla Ge
256 Tabla Ka
257 Tabla Te
258 Tabla Na
259 Tabla Tun
260 Dholak Ge
261 Dholak Ke
262 Dholak Ta 1
263 Dholak Ta 2
264 Dholak Na
265 Dholak Ta 3
266 Dholak Ring
267 MridangamTha
268 MridangmDhom
269 MridangamDhi
270 MridangmDhin
271 MridangamNum
272 Ban Gu
273 Hu Yin Luo
274 Xiao Luo
275 Xiao Bo
276 Low Tang Gu
277 Mid Tang Gu
278 High Tang Gu
279 Tablah 1
280 Tablah 2
281 Tablah 3
282 Daf 1
283 Daf 2
284 Riq 1
285 Riq 2
286 Riq 3
287 Davul 1
288 Davul 2
289 Zill 1
290 Zill 2

Number Wave Name
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